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Trademarks and Copyrights 

Trademarks 

Woodstone is a registered trademark of Woodstone bvba. 

Oracle is a registered trademark of Oracle Corporation. Novell is a registered trademark of Netware. 
ICQ is a trademark of ICQ. Windows, Windows NT, and MSN are registered trademarks of Microsoft 
Corporation. Citrix is a registered trademark of Citrix Systems, Inc. UNIX is a registered trademark of 
The Open Group.  

All other brands and product names are trademarks or registered trademarks of their respective 
owners. 

Statement of Copyrights 

The product is, and remains, Copyright © 1997-2003 Woodstone bvba. All Rights Reserved Including 

software, file formats, and audiovisual displays; may be used pursuant to applicable software license 

agreement; contains confidential and proprietary information of Woodstone bvba and/or third parties 

which is protected by copyright and trade secret law and may not be provided or otherwise made 

available without proper authorization. 

Warranties and Liabilities  

All warranties given by Woodstone bvba about software are set forth in your purchase contract, and 

nothing stated in, or implied by, this document or its contents shall be considered or deemed a 

modification or amendment of such warranties. Woodstone bvba believes the information in this 

publication is accurate as of its publication date. The information and the software discussed in this 

document are subject to change without notice and are subject to applicable technical product 

descriptions. Woodstone bvba is not responsible for any error that may appear in this document.  

The software discussed in this document is furnished under a license and may be used or copied only 

in accordance with the terms of this license.  

No responsibility is assumed by Woodstone bvba for the use or reliability of software. THE USER OF 

THE SOFTWARE IS EXPECTED TO MAKE THE FINAL EVALUATION AS TO THE 

USEFULNESS OF THE SOFTWARE IN HIS OWN ENVIRONMENT.  
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License Agreement 

Following are various statements that detail the proper use of Servers Alive.  If you have any questions 
regarding the following sections, please contact legal@woodstone.nu (mailto://legal@woodstone.nu). 

The freeware version is limited to checking 10 entries.  You can register the product and then you can 
check up to 1000 entries, for the standard edition, or 5000 entries, for the Enterprise Edition. 

This license agreement covers your use of the Woodstone bvba’s Servers Alive, its executable files and 
documentation, hereinafter referred to as the Product.  

The Product is Copyright © 1997-2003 Woodstone bvba. You may use it and distribute it according to 
this following License Agreement. If you do not agree with these terms you must remove the Product 

from your system.  

By incorporating the Product in your work or distributing the Product to others you implicitly agree to 

these license terms.  

This License Agreement covers the current version of the product. Woodstone bvba reserves the right 

to modify the terms of this License Agreement at any time, and without prior notification, in future 

releases of the product.  

Conditions Of Use 

The Product is provided in one form: as a ready-to-run installation kit consisting of executable 

programs, release notes, and so forth (the Product Executable).  

You may freely use and distribute the Product Executable so long as you provide the complete and 

unmodified original Product Executable installation kit as supplied by Woodstone bvba.  

Disclaimer Of Warranty 

The Product is provided as free software, in the hope that it will be useful. It is provided "as-is", 

without warranty of any kind, either expressed or implied, including, but not limited to, the implied 

warranties of merchantability and fitness for a particular purpose. The entire risk as to the quality and 

performance of the Product is with you. Should the Product prove defective, the full cost of repair, 

servicing, or correction lies with you. The freeware version is limited to checking 10 hosts. You can 

register the product and then you can check up to 1000 entries, for the standard edition, or 5000 

entries, for the Enterprise Edition.  

Conditions 

For commercial distributors, other licensing conditions may be negotiated with respect to technical 

support and redistribution rights.  Before reselling Servers Alive, you must contact Woodstone bvba to 

negotiate a redistribution license. 
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Welcome to Servers Alive, the award winning monitoring tool from 
Woodstone bvba. Servers Alive is designed to monitor many different 
types of servers and services from a centralized location and report their 
status. It supports many generalized tests applicable to servers of all 
types, along with specialized tests for certain types of services. When it 
detects that a server or service has become unavailable it is capable of 
reporting this condition in a variety of ways. It can even act to take care 
of the problem without any human interaction. 

Servers Alive is used all over the world by companies in all types of 
businesses, from computer to legal, military to government. They rely on 
it to monitor their mission critical servers. Servers Alive is a compact and 
inexpensive tool, but it packs a lot of punch. It has a feature set that 
compares favorably with the most popular monitoring packages available, 
but sells for a fraction of the cost.  You can register the product and then 
you can check up to 1000 entries with the Standard edition and up to 
5000 with the Enterprise version. 

We’re sure you’ll enjoy your experience with Servers Alive. As such, we 
offer the product free to those who only wish to monitor ten or less 
servers or services. We’re confident you’ll see the incredible worth you 
can get out of this amazing product!   

In This Chapter 

Installation ......................................................................... 3 
Getting Started in the Main Window................................. 7 
Technical Support .............................................................. 11 
What’s New? ...................................................................... 13 
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Installation 

Servers Alive has the following requirements for installation:   

1 Windows® 2000 (Professional or Server edition), NT® (Workstation 

or Server edition), ME, 98, and XP.  

2 Network Interface Card   

3 TCP/IP   
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You can purchase two different versions of Servers Alive: 

� The Standard version accepts 1000 entries.  

� The Enterprise edition accepts 5000 entries and provides logging 
capabilities to an ODBC-compliant database. 

Before Installing Servers Alive 

Please note that you must be an administrative user on the computer 
before you can install Servers Alive. Also note that, on Windows 2000, 
you must have the telephony service running or the CPU goes to 100% 
utilization.  

Make sure that Windows has been updated to include the most recent 
patches provided by Microsoft® . This ensures the best possible 

compatibility. If you plan to use Servers Alive to check Oracle®  or MS 

SQL®  databases, you must install the corresponding client software 

provided by the database manufacturer, as Servers Alive uses the client to 
perform its checks. If you check any Novell®-specific servers, you must 

install the Client for Novell Networks provided by Novell. The Novell 

client provided by Microsoft is not sufficient for the Netware® checks. 

  

Downloading Servers Alive 

Servers Alive is obtained primarily through an Internet download: 

http://www.woodstone.nu/salive (http://www.woodstone.nu/salive). You 

can find the download link on that page, or you can choose from any of 

the worldwide mirrors.   

Woodstone bvba can ship a CD to you when you purchase the full 

version of the software. There is only one version of the software, 

regardless of whether you use it for ten or less entries or whether you 

have purchased a full license. 
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Installing Servers Alive  

Once you have downloaded the software package and saved it to a 
convenient location, launch the installation program.  

Note that you cannot install Servers Alive through a Terminal Server 
session, and, when running Servers Alive as a service through Terminal 
Server, you cannot see the tray icon.  

The installation program asks you for a location where it can install the 
software, which you can set to any location you want. The install 
program extracts all program files to the location you specify and creates 
entries for Servers Alive on your Start Menu under the heading Alive.  

Servers Alive can be run as a service if the computer you install it on is 
running Windows NT, 2000, or XP. The Setup process detects your 
operating system and the service automatically installed, if the process 
does not detect Windows NT, 2000, or XP. For Servers Alive to start 
automatically when you turn on your computer, you must go to the 
Services control panel and set the service called Servers Alive to 
automatic startup. 

Extending Servers Alive   

When Servers Alive is installed, it also installs a few companion 
applications that you can use to extend the functionality of Servers Alive. 
A subdirectory called External includes some sample external check 
applications that you can use. Woodstone bvba creates and maintains the 
applications that are included in the external directory, but there are other 
applications, made by other authors, provided free, that you can 
download from the Woodstone bvba web site. There are also some 
applications in the main Servers Alive directory that you can use to create 
your own external checks. For more information, reference the External 
Checks (on page 237) section.   

Configuring Servers Alive 

Before adding any monitored entries to Servers Alive, you need to 
configure its various options and features. Servers Alive has many 
powerful features that you can use to tweak the monitoring process. You 
should configure these before adding any entries, as you cannot use most 
of the alerting or monitoring features without globally configuring them 
first.   

The first thing to do is enter your registration code if you purchased the 
product. You can do this by selecting the Register menu option from the 
Main window. This menu option is visible only in the unregistered 
product. Woodstone bvba sends an e-mail with the required name, 
company, and registration Code when you purchase the software. If you 
do not have a registration code, please send an e-mail to 
support@woodstone.nu (mailto:support@woodstonebvba.nu).   
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Next, you can click the Setup button on the Main window. You can 
configure how Servers Alive monitors and alerts you by setting various 
options in the tree.  
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Getting Started in the Main Window 

The Main window includes a listing of all entries that have been created. 
Each row in the entry list displays an entry item.  The entry list shows the 
last detected condition, and, when a check cycle is in progress, displays 
the item that is currently being checked.  You can use the Main window 
to control the check cycle, work with dependences, and to make global 
changes to all entries. 

To get additional information about a dialog box or command, select the 
menu command and press F1on the keyboard. Or, you can open a dialog 
box and press F1. 

Moving, Displaying, Hiding Columns 

The Main window displays the following columns: 

� Host ID Column 

� Last Checktime Column 

� Roundtrip Column  

� Response Column  

� Status Column  

� Pretty Name Column 

� Host Name Column  

� Check Description Column 

 

 
 

You can customize your own view of the item entries by doing one of the 
following:  

� Click the column heading to re-sort the list.  

If you resort, this affects the order in which Servers Alive checks the 
entries, but the software tracks the correct checking order for the 
dependencies.  

C H A P T E R  2  

Figure 1: Main Window 
(1) 
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� Click and drag the column heading to the place you want to change 
the order of the columns. 

� You can hide different columns by selecting the name of the column 
on the View menu. 

� You can also display or hide the status icons by selecting Status Icons 
within Tree. 

By default, the software asks you to confirm if you want to drag and drop 
an entry on the Main window. To turn this off, you must add the 
following registry key and then assign a value of 1: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBUConsulting\Servers 
Alive\StartUp\No_confirmation_for_Drag_and_Drop (dword) 

Adding and Editing Entry Items 

You can add an entry item by clicking the Add button on the Main 
window. If you want to change the configuration of Servers Alive while 
adding entries, click the Setup button. If you want to delete an item, select 
the row for the item and click the Delete button. 

 

 

Organizing Entries with Groups 

You can organize your entries in the Main window by grouping them 
together. In the list in the Main window, select My Entries and right-click. 
Select Add Group on the shortcut menu. You can also rename a group by 
selecting My Entries or another group that you created and then clicking 
Rename Group on the shortcut menu. When you want to delete a group, 
select the group, right-click, and click Delete Group. 

Check Cycles 

Servers Alive performs a check cycle starting from the top of the entry 
list working to the bottom of the list.  The software auto-arranges the list 
of entries by host in the correct order for the dependencies to work 
properly.  

You can set how often the software checks the servers by entering the 
seconds or minutes that you want in the  Checks Done Every __ 
Seconds/Minutes box. You can set whether this box displays seconds or 
minutes. To do this, click File > Setup. In the Setup tree, click General > 
Startup. You can enter the number by clicking Setup > Misc in the Setup 
tree. 

Figure 2: Main Window 
(2) 
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Start, Stop, Pause, and Update Buttons 

There are four command buttons in the lower right-hand corner of the 
Servers Alive interface, called Start, Stop, Pause and Update.  Use these 
buttons to control the check cycle.  If you pause the check cycle, it stops 
where it is and allows you to resume when ready.  Note, however, that it 
only pauses until the next schedule check cycle, at which time the 
software checks entries again automatically.  If you need to stop the 
check cycle for a long period of time, click the Stop button instead.  
When you are ready to resume, use the Start button.  When you click the 
Update button, the software immediately begins a new check cycle.  

Rechecking an Active Entry 

You can recheck a single entry that has gone down to verify its condition.  
You do this by first clicking the Stop button to stop any check cycle 
currently in progress.  Select an entry and right-click to select Check Now. 
Servers Alive checks that single entry and displays the status in the left-
most column. 

Statistics 

Servers Alive maintains statistics on the availability of the servers that 
you monitor. You can access these statistics by first selecting an entry, 
then right-click, and select the Statistics command on the shortcut menu.  
The statistics box displays response time statistics, showing the 
minimum, maximum, and average response times. The dialog box also 
shows how many times the server was detected as up and down.  There is 
currently no process to produce reports based on this information. 

 

 

Active and Maintenance Modes 

An entry can be in one of two modes: Active or Maintenance.  Hosts are 
only included in the check cycle if they are active.  Most entries stay in 
active mode all the time and only can be switched to maintenance mode 
when some work is being performed on them.  If you have regularly 
scheduled maintenance periods for a server, you should click the Add 
button and use the Schedule tab in the host entry to schedule periods 
when the item is switched to maintenance mode. 

Figure 3: Main Window 
(3) 
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You can change an entry from active to maintenance states quickly and 
easily. Select an entry in the Main window and right-click. You can then 
select Active or Maintenance from the shortcut menu. 

Sound 

If you want to turn off the sound, select an entry and right-click. Select 
Mute Sound on the shortcut menu. 
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Technical Support 

E-mail 

Limited e-mail support is available from support@woodstone.nu 
(mailto:support@woodstonebvba.nu).   

Full guaranteed technical support is subject to a Woodstone bvba support 
license.  For current prices and conditions, please e-mail  
support@woodstone.nu (mailto:support@woodstonebvba.nu).   

Mailing List 

This list is very helpful. To sign up for the list, go to 
http://www.woodstone.nu/salive/subscribe.html 
(http://www.woodstone.nu/salive/subscribe.html).   
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What’s New? 

Servers Alive has the following new features: 

1 The two different versions of Servers Alive provide different logging 
capabilities: 

The Standard version accepts 1000 server entries.  

The Enterprise edition accepts 5000 entries and provides logging 
capabilities for an ODBC database. 

2 The Setup dialog box is easier to use. It displays a tree view for all 
options. 

3 The Winsock checks are now protocol-oriented; they are no longer 
port-oriented. For example, in Version 3.3, if you run a check on port 
25, the check is always SMTP. Now, in Version 4, you can select the 
protocol and define the port that you want.  

4 Each entry item can now have many different alerts, each with its 
own settings. 

5 Servers Alive now arranges hosts in the Main window in the correct 
order for the dependencies to work properly. If you resort, this affects 
the order in which Servers Alive checks the entries, but the software 
tracks the correct checking order for the dependencies.  
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The File menu has many commands that help you manage your 
information. 

In This Chapter 

Introduction to the File Menu ............................................ 17 
Setup Dialog Box (Main Window).................................... 19 
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File Menu 
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Introduction to the File Menu 

The File menu has the following commands: 

� File - open a new list of entries. 

� Import Old Hostfile - open a host file saved in earlier versions of 
Servers Alive. 

� Save - save your settings and list of entries. The Save command 
prompts you for a location and name to save the list of entries.  Select 
a location and name that is easy to remember.   

� Save As - save your list of entries as a text file with a .txt extension. 

� Exit - close Servers Alive. 

� Setup - edit the global settings for Servers Alive. You can also click 
the Setup button in the Main window. 

� Most Recently Used List - displays the list of most recently used host 
files. 

If you want Servers Alive to load a listing by default, you can set that by 
clicking the File > Setup command and then entering the information on 
the Startup tab. 
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Setup Dialog Box (Main Window) 

 

 

The Setup dialog box allows you to enter global settings for Servers Alive 
with the following branches in the Setup tree: 

� Alerts 

� Logging 

� Output 

� General 

� Built-in Servers 

When you select a branch in the tree, different setup options appear on 
the right side of the dialog box. 

 
 

Figure 4: Setup (Main) 
(1) 
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Alerts 

The Alerts tab specifies the alerts that are sent when a server 
malfunctions. When Servers Alive detects a down condition, it can 
respond with a wide array of notifications and alerts, depending on the 
settings that you choose, including the following: 

� Sending an e-mail (SMTP) saying what is down 

� Paging you with a numeric or alphanumeric warning 

� Executing a program 

� Playing a sound 

� Creating a web or WAP page 

� Restarting an NT service 

Mail alerting is one of the most common types of alerting used.  Servers 
Alive supports two different methods of sending mail:  SMTP and Other 
Mail.  Usually, you should choose settings on the SMTP tree unless your 
mail server does not support SMTP or you have special mailing needs. In 
these cases, you should examine the Other Mail options in the tree. 
 

SMTP 

Mail alerting is one of the most common types of alerting used.  Servers 
Alive supports two different methods of sending mail:  SMTP and Other 
Mail.  Usually, you should choose settings on the SMTP tree unless your 
mail server does not support SMTP or you have special mailing needs. In 
these cases, you should examine the Other Mail options in the tree.   
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Primary 

 

 

Enable Primary SMTP Mail 

Enables this feature and allows you to enter values on the dialog box. If 
you do not click this box, the software sends mail through both the 
primary and alternate SMTP servers.  

Mail Host 

Enter the mail hst as a NetBIOS name, DNS name or IP address; for 
example, HERMES, mail.domain.com, or 123.45.67.89. 

From 

Enter a name or a fully-qualified domain name; for example, Servers 
Alive or serversalive@company.com. Your entries depend on the way 
your SMTP server is configured; most SMTP servers require a FROM 
name that looks like a valid e-mail address, such as salive@domain.com.  
If you have trouble, please contact your mail server administrator for the 
appropriate settings. 

To 

Enter an e-mail address, such as person@company.com. To send the 
message to several e-mail addresses, separate the addresses with a 
comma. For example, user1@company.com,user2@company.com. 

Test It  

Sends a test message to the specified users. Remember to click the APPLY 
button first; otherwise, Servers Alive uses the previous values for the test 
mail.   

Figure 5: Primary (1) 
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Fall Back to Alternate When Primary Not Responding Correctly 

Check so that the alternate server is used only when the primary server is 
down or not responding correctly.   

Ping Settings 

Before sending a mail, Servers Alive pings the SMTP server to see if it is 
responding. You can use the following SMTP\PingTimeout parameter to 
determine the amount of time Servers Alive should wait for a response 
(max. 32 sec).  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\pingtimeout (dword)  

Servers Alive can send you an e-mail every few minutes, based on the 
interval that you choose, to show that the software is still running. The 
mail is sent using the default settings of the primary SMTP server.  When 
Servers Alive starts/stops checking, it can also send an e-mail, using the 
settings of the primary SMTP server.  Before sending e-mail to an SMTP 
server, Servers Alive pings the server and only sends e-mail to the server 
if it gets a response. If your server is not responding to pings, because a 
router or fire wall filters out the ICMP packages, the e-mail is not sent. 
You can disable this ping-before-send feature to get around this.  All e-
mail sent by Servers Alive is by default sent as URGENT e-mail (high 
priority).    

By default, the keep-alive mailings are sent to the default primary Mailto 
parameter. This can be altered with the following registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\KeepAliveTo (string) 

SMTP Timeout 

There is another parameter called SMTP\Timeout that controls how long 
Servers Alive waits for the SMTP server to respond.  The default is 15 
seconds, and the maximum is 60 seconds. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\timeout (dword)  

If SMTP/ResolveAtStart equals 1, then Servers Alive attempts to resolve 
the SMTP, and alternate SMTP, server name to its IP address when 
Servers Alive starts and uses that from then on.  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\ResolveAtStart (dword) 1 or 0.  

If ExcludeDateTimeInMail is 1, the generated SMTP mailings do NOT 
include the last line (Mail generated by ... date/time).  
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) 1 or 0  

Alternate Ports and Servers 

You can specify an alternate port, although not 25, for the primary and 
alternate SMTP server by modifying the following keys: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\PrimarySMTPPort (string)  

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\AlternateSMTPPort (string) 

Custom  Mail Headers and Footers 

You can use the following keys to add custom headers to any SMTP mail 
Servers Alive sends: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\PrimaryXHeader (string)  

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\AlternateXHeader (string) 

You can use the following keys to add custom footers to any SMTP mail 
Servers Alive sends: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\PrimaryFooter (string)  

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\AlternateFooter (string) 

You can use the following variables in the PrimaryFooter entry: 

� {time}  hh:mm:ss format 

� {date} 

� {stime} hh:mm format 

� {saversion} Servers Alive version number 

� {0d}  Carriage return character 

� {0a}  New line character 

Advanced Settings for the SMTP Primary Tree: DUN and 
ESMTP 
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Servers Alive uses your LAN (network) connection to send the mail to 
your SMTP server. Servers Alive can also do this via DUN (Dial Up 
Networking).  

Servers Alive sends SMTP mail through your usual LAN connection 
(__LAN__). You can, however, force Servers Alive to dial into a remote 
network before sending mail to an SMTP server. To do this, you first 
must configure the correct Dial-up Networking settings in Windows.  
You can then select them using the appropriate drop down boxes on the 
DUN-SMTP branch of the tree.  If you need to provide a user name, 
password, and domain to establish the connection, you can enter them in 
the appropriate text boxes. 

Many organizations do not allow standard SMTP connections for 
outgoing mail, as outside spammers use them to send unsolicited mail.  
Most have an option to use ESMTP, which forces a person to log in to the 
SMTP mail server before allowing that person to send any mail.  If your 
company uses ESMTP, you must supply a use name and password 
combination for your primary and/or alternate mail settings to allow 
Servers Alive to send mail.   

To use this, select Yes in Use Authentication, and then type in the user 
name and password. 

Servers Alive also supports ESMTP and POP3 authentication. 
 

Figure 6: Primary (2) 
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Alternate 

 

 

Enable Alternate SMTP Mail 

Enables this feature and allows you to enter values on the dialog box. If 
you do not click this box, the software sends mail through both the 
primary and alternate SMTP servers.  

Mail Host 

Enter the Mail Host as a NetBIOS name, DNS name or IP address; for 
example, HERMES, mail.domain.com, or 123.45.67.89. 

From 

Enter a name or a fully-qualified domain name; for example, Servers 
Alive or serversalive@company.com. Your entries depend on the way 
your SMTP server is configured; most SMTP servers require a FROM 
name that looks like a valid e-mail address, such as salive@domain.com.  
If you have trouble, please contact your mail server administrator for the 
appropriate settings. 

To 

Enter an e-mail address, such as person@company.com. To send the 
message to several e-mail addresses, separate the addresses with a 
comma; for example, user1@company.com,user2@company.com. 

Test It  

Sends a test message to the specified users. Remember to click the Apply 
button first; otherwise, Servers Alive uses the previous values for the test 
mail.   

Figure 7:  Alternate (1) 
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Fall Back to Primary When Alternate Not Responding Correctly 

Check so that the primary server is used only when the alternate server is 
down or not responding correctly.    

Ping Settings 

Before sending a mail, Servers Alive pings the SMTP server to see if it is 
responding. You can use the following SMTP\PingTimeout parameter to 
determine the amount of time Servers Alive should wait for a response 
(max. 32 sec).  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\pingtimeout (dword)  

Servers Alive can send you an e-mail every few minutes, based on the 
interval that you choose, to show that the software is still running. The 
mail is sent using the default settings of the primary SMTP server.  When 
Servers Alive starts/stops checking, it can also send an e-mail, using the 
settings of the primary SMTP server.  Before sending e-mail to an SMTP 
server, Servers Alive pings the server and only sends e-mail to the server 
if it gets a response. If your server is not responding to pings, because a 
router or fire wall filters out the ICMP packages, the e-mail is not sent. 
You can disable this ping-before-send feature to get around this.  All e-
mail sent by Servers Alive is by default sent as URGENT e-mail (high 
priority).    

By default, the keep-alive mailings are sent to the default primary Mailto 
parameter. This can be altered with the following registry key. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\KeepAliveTo (string) 

SMTP Timeout 

There is another parameter called SMTP\Timeout that controls how long 
Servers Alive waits for the SMTP server to respond.  The default is 15 
seconds, and the maximum is 60 seconds. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\timeout (dword)  

If SMTP/ResolveAtStart equals 1, then Servers Alive attempts to resolve 
the SMTP, and alternate SMTP, server name to its IP address when 
Servers Alive starts and uses that from then on.  
HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\ResolveAtStart (dword) 1 or 0.  

If ExcludeDateTimeInMail is 1, the generated SMTP mailings do NOT 
include the last line (Mail generated by ... date/time).  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) 1 or 0  
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Alternate Ports and Servers 

You can specify an alternate port, although not 25, for the primary and 
alternate SMTP server by modifying the following keys: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\PrimarySMTPPort (string)  

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\AlternateSMTPPort (string) 

Custom  Mail Headers and Footers 

You can use the following keys to add custom headers to any SMTP mail 
Servers Alive sends: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\PrimaryXHeader (string)  

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\AlternateXHeader (string) 

You can use the following keys to add custom footers to any SMTP mail 
Servers Alive sends: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\PrimaryFooter (string)  

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\AlternateFooter (string) 

You can use the following variables in the PrimaryFooter entry: 

� {time}  hh:mm:ss format 

� {date} 

� {stime} hh:mm format 

� {saversion} Servers Alive version number 

� {0d}  Carriage return character 

� {0a}  New line character 

Advanced Settings for the SMTP Primary Tree: DUN and 
ESMTP 
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Servers Alive uses your LAN (network) connection to send the mail to 
your SMTP server. Servers Alive can also do this via DUN (Dial Up 
Networking).  

Servers Alive sends SMTP mail through your usual LAN connection 
(__LAN__). You can, however, force Servers Alive to dial into a remote 
network before sending mail to an SMTP server. To do this, you first 
must configure the correct Dial-up Networking settings in Windows.  
You can then select them using the appropriate drop down boxes on the 
DUN-SMTP branch of the tree.  If you need to provide a user name, 
password, and domain to establish the connection, you can enter them in 
the appropriate text boxes. 

Many organizations do not allow standard SMTP connections for 
outgoing mail, as outside spammers use them to send unsolicited mail.  
Most have an option to use ESMTP, which forces a person to log in to the 
SMTP mail server before allowing that person to send any mail.  If your 
company uses ESMTP, you must supply a use name and password 
combination for your primary and/or alternate mail settings to allow 
Servers Alive to send mail.   

To use this, select Yes in Use Authentication, and then type in the user 
name and password. 

Servers Alive also supports ESMTP and POP3 authentication. 

 
 

Figure 8: Primary (2) 
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Numeric Paging 

 

 

You must install a modem in Windows to use this feature. 

Enable Pager 

Enables Servers Alive to send you alerts through an attached modem to a 
numeric pager.  

Phone Number 

Specify a phone number of your numeric pager to which Servers Alive 
can send a message.  

End Message Indicator 

After a numeric message has been entered, specify an end-of-message 
indicator. Generally paging providers use # as the indicator. 

Wait String 

Specifies the wait time for Servers Alive. In most cases, after dialing the 
phone number of your pager, Servers Alive must wait several seconds 
before sending out the numeric information. You can enter a time in the 
Wait box as some number of commas. Every “,” represents about 2 

seconds.   

Add 0 When Down and 1 When Back Up to Host-id 

Figure 9: Numeric 
Paging (1) 
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Check this option to receive extended information on your page. Servers 
Alive adds a -0 for a down-host to the host ID and a -1 for an up-host to 
the host ID. Numeric paging is  unreliable because it is not based on any 
standard protocol.  

The message that you get on your pager displays a number. This number 
is the Host ID, which you can change when creating or editing a host.  

If you enabled the Add 0 When Down and 1 When Back Up to Host-id 
option, Servers Alive sends a "-" (dash) between the host ID and the 0/1 
(down/up). You can change this if you add or edit the following registry 
value: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBUConsulting\Servers 
Alive\Pager\Separatorstring (string)  

Port to Use 

Specifies the COM port to which your modem is attached. In most cases, 
you can enter TAPI.   When using TAPI, Servers Alive uses only the 
TAPI modem that you installed first.  

Remember that you must enable paging on a host-by-host basis. By 
default, you are not paged by any hosts when a DOWN condition is 
detected.  Note that, because numeric paging is not based on a standard 
protocol, numeric paging is not as reliable as alphanumeric paging. 

Test It 

Tests the pager. Remember to click the Apply button first, or Servers 
Alive uses the previous settings.  
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Alpha Paging - SMS 

 

 

You must install a modem in Windows to use this feature. 

One of the most common methods of alerting is alphanumeric paging. 
You can send small alerts to your alphanumeric pager detailing exactly 
what has gone down, often with collaborating information.  To do this, 
you must provide a modem device that allows you to send alphanumeric 
pages.  The actual paged device or number is added on a host-by-host 
basis. 

Enable Alpha Paging and SMS Messaging 

To turn on this feature, click the Enable Alpha Paging & SMS Messaging 
box. 

Devices   

Configure the device that Servers Alive uses to send the message.  Click 
the Devices list to choose a modem.  This drop down box displays any 
modems that you have installed in Windows.   

Comm Settings  

Enter the communication settings in the Comm Settings box. Contact your 
paging/SMS provider for these settings, along with the protocol and 
SMSC.   

Figure 10: Alpha Paging 
- SMS (1) 
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In general, you can try entering 7E1 or 8N1. Woodstone bvba maintains 
an informal list with settings reported by users of Servers Alive for 
providers around the world.  You can find this list at 
http://www.woodstone.nu/salive/pagersettings.asp 
(http://www.woodstone.nu/salive/pagersettings.asp).  Woodstone bvba 
takes no responsibility for the accuracy of the supplied information, but it 
might be helpful.  

Baud rate 

Choose a setting that is appropriate for your service provider. 

Devices 

SMSC No 

Enter the phone number of your service provider’s modem. 

Protocol to Use 

Select the protocol used by your provider. This is either TAP or UCP.  

UCP Operation  

If your provider uses UCP, you must also specify settings for the UCP 
Operation box.   

You can look at the list at 
http://www.woodstone.nu/salive/pagersettings.asp 
(http://www.woodstone.nu/salive/pagersettings.asp), but the information 
might not be listed for your provider or contain up-to-date settings.  
Please contact your provider for the correct information. 

Message 

In the Message section, you must provide authentication information.  
This information is available from your provider and is required in order 
to send a message.   

Sender 

Enter the name of the sender for authentication purposes. In most cases, 
this can be left blank. 

Legitimization Code 

Enter the code, if required by your provider.  

Authentication Code 

Enter the authentication, if required by your provider. 

Send Multiple Messages Per Call 
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Allows the software to send multiple messages per call. 

Max. Number of Messages per Call 

Specifies the maximum number of messages allowed. 

Format  

Enter ALPHA NUMERIC, in most cases. 

Receipt Type 

Enter GSM, in most cases. 

Test It 

Tests the settings to receive a test page. Remember to click the Apply 
button first, or Servers Alive uses the previous settings.  

Note that, in some rare cases, the SMS message must be sent twice before 
it is received. To enable this feature, you must add or edit the following 
registry entry. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\Paging\DoubleMessage (dword) 1 or 0 
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Audio 

 

 

If you have the Servers Alive monitoring server near your operations 
staff, you can use audible alerts to tell them that something is down.   

Enable Audio Alarm 

If you want Servers Alive to warn you of a failure with a sound, click the 
Enable Audio Alarm box. If no WAV-capable device is available, you 
cannot check the Enable Audio Alarm check box. However, you can still 
use some sounds as alarms by enabling the Beep via Speaker option.  

File to Play 

Select a WAV file on the computer. The file name you enter is the default 
that Servers Alive uses. You can set a different file name for every host.  

Beep Via the Speaker 

Select this if you do not have a device on your computer that is capable of 
playing WAV files. 

Test It 

Tests the settings. You should receive a test page. Remember to click the 
Apply button first, or Servers Alive uses the previous settings.   

Servers Alive plays a sound when starting or stopping as a proof that it is 
still alive. You must add or edit the following registry keys: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\KeepAlive\StartSound (string)  

Figure 11: Audio (1) 
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� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\KeepAlive\StopSound (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\KeepAlive\KeepAliveSound (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\KeepAlive\KeepAliveSoundMinutes (dword) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\KeepAlive\KeepAlivewithSound (dword) 1 to enable  
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SNMP Trap 

 

 

SNMP Trap 

Enables this feature and allows you to enter settings on the dialog box. 

Receiver 

Indicates the name of the destination host 

Community 

Enter a community string to use in the traps that the software sends in the 
Community box.  

Sender OID 

Controls which varbinds to include in the trap; all varbinds are included 
by default.  

Sender IP 

Specifies the destination host name or IP address for sending traps.  

Log Trap Sending to Logfile 

Writes the event to a file. 

Port 

Indicates the destination port for sending traps. 

Test It 

Figure 12: SNMP Trap 
(1) 
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Tests the settings. Remember to click the Apply button first, or Servers 
Alive uses the previous settings.   
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Other Mail 

 

 

Servers Alive can natively send mail via an SMTP server. If you are not 
using an SMTP server, Servers Alive can still send mail using your mail 
server, if you define a command line mailer for your mail system. 

For each entry, you can define an alert that sends a message using Other 
Mail. This alert has its own message and uses the send options defined 
within the alert.  See the Other Mail (on page 159) section for more 
information. 

Enable Other Mail 

Click the check box to allow Servers Alive to send mail using the 
command line mailer you specify. 

Command Line 

Defines the command line that the software uses. You can define an alert 
for each entry that sends a message using these settings. The entry has its 
own message. In the command line, you enter the command that Servers 
Alive issues when sending mail with your command line mailer. Within 
the command line, the %m is replaced with the actual message that 
Servers Alive generates. 

Test It 

Tests the settings.  You should receive a test message. Remember to click 
the Apply button first, or Servers Alive uses the previous settings.   

You can modify the message that Servers Alive sends by adding or 
editing the following registry value: 

Figure 13: Other Mail 
(1) 
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\OtherMail\OtherMessage (string)  

Within this "othermessage" value you can use the following variables: 

%h for the host name  

%p for the pretty name  

%s for the status  

%t for the last check time  

%d for the date  

%u for the unique ID of the host  

%c for the complete host/check description  

%e for extra info (for a URL checking this could contain 404 Not Found 
as the error message)  

%a for additional info (for a ping check this will the round trip time)  

%i for hosted (used for numeric paging)  

{0d} for chr(13) – carriage return 

{0a} for chr(10) – line feed 

If you want to force the case of the message to uppercase or lowercase 

only, you must add or edit the following registry key.  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 

Alive\Othermail\ForceCase (string) U or L 
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ICQ 

 

 

When Servers Alive sends an ICQ™  alert, it sends an ICQ page. When 

your ICQ software detects the incoming page, the software announces 

this with a sound. The software does not flash the minimized ICQ icon 

that is displayed in the Windows system tray.  

Enable ICQ 

Click this check box to enable this feature and enter information on the 

dialog box. 

From Name 

Enter the name that you want to appear on the alert message as the 
sender. ICQ does not have to recognize the name. 

From Email 

Enter the e-mail account from which you want to send the alert. 

Default To 

Enter an ICQ number to which the alert message is sent. This is the ICQ 

number for your account.  

Default Subject 

Enter a subject for the message. 

Default Message 

Figure 14: ICQ (1) 
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Enter text for the body of the message. This is the default text for the alert 
message. 

Proxy to Use 

Specify the proxy for the alert message. 

Test It 

Tests the settings.  You should receive a test message. Remember to click 
the Apply button first, or Servers Alive uses the previous settings. 
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MSN Messenger 

 

 

In order to send a Microsoft Network (MSN® ) message, Servers Alive 

must log on to the MSN network. Because an MSN user can have only 

one concurrent log-in, you should use a different user account for sending 

the MSN alerts, than the user account that you use to receive the alerts. 

Enable MSN® 

Click this check box to send messages over the Microsoft Network 

(MSN) messenger service and enter information on the dialog box. 

From (MSN Username) 

Enter the name for your MSN account. 

From (MSN Password) 

Enter the password for your MSN account. 

Default To 

Enter the default name to appear in the To line of the message. 

Default Message 

Enter text that you want to appear in the message each time it is sent. 

Test It 

Tests the settings.  You should receive a test message. Remember to click 

the Apply button first, or Servers Alive uses the previous settings.  
 

Figure 15: MSN 
Messenger (1) 
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SNPP (Network Paging) 

 

 

Enable SNPP 

Allows you to send messages over the Simple Network Paging Protocol 
(SNPP). Click the check box to enable the feature and enter values on the 
dialog box. 

SNPP Host 

Enter the name of the host. 

Port 

Enter the port that you want to use. 

Caller ID 

Enter the called id of your SNPP account. 

Timeout 

Enter the time that you want Servers Alive to keep trying to send you a 
message. 

Default Pager ID 

Enter the pager id. 

Default Message 

Enter the text that you want to appear in the body of the message. 

Figure 16: SNPP 
(Network Paging) (1) 
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Test It 

Tests the settings.  You should receive a test message. Remember to click 
the Apply button first, or Servers Alive uses the previous settings.   
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Logging 

The two different versions of Servers Alive provide slightly different 
logging capabilities: 

� The Standard version accepts 1000 entries.  

� The Enterprise edition accepts 5000 entries and provides logging 
capabilities to an ODBC-compliant database. 

 

Logfile 

For more information about logging to a file or to a database, see one of 
the following sections. 
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To File (Logfile) 

 

 

Enable File Logging 

Click the check box to enable Servers Alive to log all its activities to a 
log file. 

Log File 

Fixed Name 

Select this box and enter the name of the log file, if you want Servers 
Alive to log events to a fixed log file. All new logging is appended to the 
end of the file. 

Automatically Change the Name Every Month 

Click this option to allow Servers Alive to rotate your log file every 
month. The file is written to the Servers Alive product directory. 

Automatically Change the Name Every Day 

Click this option to allow Servers Alive to rotate your log file every day. 
The file is written to the Servers Alive product directory. 

Automatically Change the Name Every Hour 

Click this option to allow Servers Alive to rotate your log file every hour. 
The file is written to the Servers Alive product directory. 

Log Options 

Advanced Options 

Figure 17: Logfile (1) 
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Path Used for Auto-Generated Logfiles 

Enter the path that you want for the log file that is automatically 
generated. By default, Servers Alive saves the log file, except for the 
fixed name log, in the same directory as Servers Alive. You can change 
this by entering the path that you want in the box. 

Username 

Enter the user name for the log file. 

Password 

Enter the password for the log file. 

When performing a URL check with a “contains” clause, Servers Alive 

saves 150 bytes (by default) of the retrieved web page in the log file. You 

can change how much is saved by changed by adding or editing the 

following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 

Alive\Log\HTTPBytesinLog (string)  

A value of -1 means the full web page. Use this with care since your log 

file will grow very fast. A value of 0 defaults back to 150 bytes.  

If you want to safe guard the Servers Alive logs against missing data due 

to power failures or critical OS errors, you can request that Servers Alive 

close the log file after each write with the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 

Alive\Log\CloseEachTime (dword) 

Value 1 forces Servers Alive to close the log file after each write (not the 

default). 
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To Database (Logfile) 

 

 

This feature is available only in the Enterprise edition of Servers Alive. 

Enable Database Logging 

Click the check box to enable this option. 

ODBC Connection String 

Enter the connection string for the Open Database Connectivity (ODBC) 
database. Click the browse button to open the  Create Database 
Connection String dialog box (on page 51) and select a data source. 

Table 

Enter the name of the table for the database that you want to send 
information to.  

Enter this name before you click the Create Table button. 

Create Table 

Click this button to create the database. 
 

Figure 18: To Database 
(Logfile) (1) 
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Create Database Connection String Dialog Box 

 

 

List of Data Sources Available 

Name  

Lists the type of databases available on your computer. 

Driver 

Lists the application drivers used to create the corresponding database. 

Username 

Enter the user name used to log in to the database. 

Use "DSN=" Syntax 

Click this check box to create a connection string in the following syntax: 

oConn.Open "DSN=mySystemDSN;" &"Uid=myUsername;" &         
"Pwd=myPassword" 

Password 

Enter the password used to log in to the database. 
 

Figure 19: Create 
Database Connection 
String Dialog Box (1) 
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Syslog 

 

 

Syslog is a standard method of centralizing various logs.  You can use a 
syslog server to store your Servers Alive logs in a remote location for 
later perusal or long-term storage.  If you want to use the Syslog feature, 
there are various freeware syslog servers on the Internet. Syslog is an 
established standard so Servers Alive works with any syslog servers.  

For a Windows based syslog server, we recommend Kiwi Syslog 
Daemon, available from http://www.kiwisyslog.com 
(http://www.kiwisyslog.com/)/. 

You must enable syslog logging for each particular entry that you want to 
log.  It is not turned on for every entry by default.  You should determine 
if you want to use this service before adding many entries so that you can 
turn it on as needed as you add entries. 

Enable Syslog 

Click to enable this feature and enter information on the dialog box. 

Syslog Host (Name or IP) 

Enter an IP address for your server.  

Port 

Enter the port for your server. The port is usually  514 unless you are 
using a non-default port number on your syslog server.  When you have 
entered the server and port, click the Apply button and then the Test It 
button. You can check the logs on your syslog server to verify that the 
server is correctly logging events from Servers Alive.   

Figure 20: Syslog (1) 
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Priority to Use When Entry Is 

Specifies which entries are logged and how often they are logged. 

Down 

Specifies how to log an entry when the server is down. You can choose 
from Emergency, Error, Alert, Critical, Warning, Info, Notice, and 
Debug. 

Up 

Specifies how to log an entry when the server is up. 

Maintenance 

Specifies how to log an entry when the server is in maintenance mode. 

Unavailable 

Specifies how to log an entry when the server is unavailable. 

When to Send 

Always 

Specifies that the log message should be sent on every check cycle. 

Status Change 

Specifies to send the log message only when the log status changes. 

Options 

Include RFC header 

Adds RFC compliancy. This RFC compliant header adds information to 
the message, such as date stamp of send, or who sent the message, and 
the name of the process that sent the message.  

Use TCP 

Sends syslog message with TCP to the remote syslog server. Most of the 
time this is accomplished on port 1468. 

Test It 

Click to verify your settings. After you have entered the server and port, 
click the Apply button and then the Test It button. You can check the logs 
on your syslog server to verify that the server is correctly logging events 
from Servers Alive.   

By default, the syslog messages sent by Servers Alive include the process 
name “Servers Alive”.  You can remove this by adding or editing the 

following registry entry: 
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SYSLog\WithoutProcess (dword) 

Value of 1 
 

Statistical Logging 

Servers Alive only writes entries to the statistical log when an entry 
changes state; for example, when an entry goes from up to down. 

You can choose to export a statistical log file to either a file or, if you 
have the Enterprise edition, a database. You can set options for either of 
these two features. 
 

To File (Statistical Logging) 

 

 

Export Statistical Logging File 

Click to activate this feature and enter settings on the dialog box. 

Path 

Enter the path to which you want to write the log file. 

File Extension 

Specify the file extension for the log file. 

Separator 

Specify the separator for entries in the log file. 

Time Unit 

Select the time unit used to indicate how long an entry was in a certain 
status before the status changed. The statistical logging creates an entry, 
in the log file, when the entry that is checked changes status; for example: 
from up to down. The logging includes the time the entry was in a 
previous status. So, for example, when the status goes from up to down, 
the record shows the time the entry was up before the server went down. 
The Time Unit box determines how the software indicates how long the 
entry was in that status: x minutes - x hours, and so forth. 
 

Figure 21: To File 
(Statistical Logging) (1) 
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To Database (Statistical Logging) 

 

 

Export Statistical Logging to Database 

Click the check box to enable this feature and enter settings on the dialog 
box. 

ODBC Connection String 

Enter the connection string for the Open Database Connectivity (ODBC) 
database. Click the browse button to open the Create Database Connection 
String dialog box (on page 51) and select a data source. 

Table 

Enter the name of the table for the database that you want to send 
information to.  

Enter this name before you click the Create Table button. 

Create Table 

Click this button to create the database. 

Time Unit 

Select the time unit used to indicate how long an entry was in a certain 
status before the status changed. The statistical logging creates an entry, 
in the database, when the entry that is checked changes status; for 
example: from up to down.  

Figure 22: To Database 
(Statistical Logging) (1) 
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The logging includes the time the entry was in a previous status. So, for 
example, when the status goes from up to down, the record shows the 
time the entry was up before the server went down. The Time Unit box 
determines how the software indicates how long the entry was in that 
status: x minutes - x hours, and so forth. 
 

Interchange Data 

You can choose to export interchange data to either a file or, if you have 
the Enterprise edition, a database. You can set options for either of these 
two features. 
 

To File (Interchange Data) 
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This feature exports a result file after each check file that contains the 
status of all entries. You must specify the file name, including the full 
path, to which the export file is written. The file is re-created during each 
check cycle, so you must get the data after each cycle. 

Format of the interchange file: 

UID, status, date (yyyymmdd), time (hhmmss), response time 

The interchange log file is overwritten after each cycle. 

Export Interchange Data to File 

Click the check box to enable this feature and enter settings in the dialog 
box. 

File Name 

Enter the name of the file to write the information to. Click the browse 
button to select a file on the computer. 

Command 

Enter the command. Click the browse button to select a command file on 
the computer. The command is executed after the interchange log file is 
generated. You can use a command to insert the interchange data into a 
database. However, this process is easier if you have the Enterprise 
edition of Servers Alive.  

Separator 

Select the separator to use as a column delimiter in the log file. 

Fields to Include in Interchange Data 

Click the following check boxes to include the information in the log. 

Host Name 

Includes the host name in the log. 

Pretty Name 

Includes the pretty name in the log. 

Check Info 

Includes information that is checked. For example, for an SMTP check, 
the check info could be (TCP port 25) - ping.  

Extra Info 

Includes the response on the check. For example, this information could 
be "Service is running" or "404 not found error" for a URL check. 
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Additional Info 

Includes additional information in the log for the round trip, or the time 
necessary to complete the test. 

Number of Cycles Since Start 

Includes the number of cycles since the start. 

The UID is the unique ID that Servers Alive assigns to each host entry. 
This UID cannot be changed. If you want to use the host ID, instead of 
the UID, you should add the following registry value:  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\Interchange\UseID 

(string) with a value of 1 
 

To Database (Interchange Data) 
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Export Interchange Data to Database 

Click the check box to enable this feature and enter settings in the dialog 
box. 

ODBC Connection String 

Enter the connection string for the Open Database Connectivity (ODBC) 
database. Click the browse button to open the Create Database Connection 
String dialog box (on page 51) and select a data source. 

Table 

Enter this name before you click the Create Table button. 

Enter the name of the table for the database that you want to send 
information to.  

Create Table 

Click this button to create the database. 

Fields to Include in Interchange Data 

Click the following check boxes to include the information in the log. 

Host Name 

Includes the host name in the log. 

Pretty Name 

Includes the pretty name in the log. 

Check Info 

Includes information that is checked. For example, for an SMTP check, 
the check info could be (tcp port 25) - ping.  

Extra Info 

Includes the response on the check. For example, this information could 
be "Service is running" or "404 not found error" for a URL check. 

Additional Info 

Includes additional information in the log for the round trip, or the time 
necessary to complete the test. 

Number of Cycles Since Start 

Includes the number of cycles since the start. 
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Output 

You can specify outputs to an HTML page or a WAP page. 
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HTML Page 

If you choose to have Servers Alive generate an HTML page that is based 
on a template, you have tools that allow you a higher degree of control 
over the final product.  To use a template, you must first tell Servers 
Alive what the end result page name is, and then select the HTML 
template to use.  Servers Alive will read through the template after each 
cycle and use it to generate the end result page. 

A template has three parts and supports a set of custom HTML tags that 
Servers Alive replaces on the fly with the associated information.  The 
three parts are the header, core, and footer.   

The header part is everything before the <sa_report> tag.  The header is 
only interpreted once per page generation.  Everything between 
<sa_report> and </sa_report> is interpreted for every host that must be on 
the page.   The footer part is the part after </sa_report> and is also 
interpreted only once.  You can add an optional parameter to sa_report 
called sort that determines how the hosts are sorted.  To sort by status, 
you would use <SA_REPORT SORT=STATUS>.  To sort by the type of 
check, you use <SA_REPORT SORT=CHECK>.  The default sort is set 
in the software. 

The interpretation of the header and footer part converts these tags to 
their current value: 

<sa_currentlongtime> - 1:32:07 PM 

<sa_currentshorttime> - 13:32 

<sa_currentlongdate> - Day, Month Date, Year (Monday, May 1, 2002) 

<sa_currentshortdate> - Day/Month/Year (5/1/2002) 

<sa_version> - ex. 2.1.952 

<sa_cycles> - Number of cycles since Servers Alive started 

<sa_cyclestart> - Date/time when the cycle started 

<sa_cyclestop> - Date/time when the cycle stopped 

Note that sa_currentlongtime, sa_currentshorttime, sa_currentlongdate 
and sa_currentshortdate use the format that is defined within the 
international settings of the control panel of the Servers Alive computer. 

Additional structures are available for headers and footers: 

� <sa_groupheader> </sa_groupheader> 

� <sa_groupfooter> </sa_groupfooter> 

� <sa_select_case STATUS> 

� <sa_case> 

� </sa_select_case> 
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The following parameters are valid within a group header and group 
footer: 

� <sa_group_name> 

� <sa_group_up_entries> 

� <sa_group_down_entries> 

� <sa_group_maintenance_entries> 

The following parameter is valid outside of the entries loop: 
<sa_receivedtraps>. 

The following parameter is valid within the entries loop: <sa_groupid>. 

Within the core section, between <sa_report> and </sa_report>, you can 
specify many more options.  You can use the following tags in the core 
section: 

<sa_hostname> 

<sa_prettyname> 

<sa_status> 

<sa_statuschangedate> 

<sa_statuschangetime> 

<sa_checkdescription> 

<sa_checkresponse> - same as the %e parameter 

<sa_hostid> 

<sa_uid> 

<sa_roundtrip> - same as the %a parameter 

<sa_threshold> 

<sa_stats_avgrtrip> - average roundtrip time of all UP cycles 

<sa_stats_maxrtrip> - maximum roundtrip time of all UP cycles 

<sa_stats_minrtrip> - minimum roundtrip time of all UP cycles 

<sa_stats_upcycles> - number of UP cycles 

<sa_stats_uptime> - uptime as a percentage 

<sa_stats_downtime> - downtime as a percentage 

<sa_stats_maintenancetime> - maintenance time as a percentage 

<sa_stats_nondowntime> - consecutive uptime 
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<sa_stats_downcycles> - number of DOWN cycles 

<sa_stats_maintenancecycles> - number of MAINTENANCE cycles 

<sa_stats_totalcycles> - number of total cycles 

<saif> 

The most powerful tag is <SAIF>.  SAIF allows you to include certain 
HTML code depending on the condition of the current host.  SAIF is used 
as follows: 

<SAIF variable IS value AND variable IS value>something</SAIF> 

<SAIF variable IS value OR variable IS value>something</SAIF> 

<SAIF variable NOT value>something</SAIF> 

Note that an SAIF statement must be on one contiguous line.  You can 
have many things inside the SAIF start and stop tags, but they must all be 
on one line, with no line breaks. 

The variables you can check are listed here along with their possible 
values: 

� SA_STATUS – possible values are UP, DOWN, MAINTENANCE, 

UNAVAILABLE, and UNCHECKED. 

� SA_CHECK – possible values are NETWARE, ORACLE, SQL, 

URL, DISKSPACE, PROCESS, SERVICE, PING, IPXPING, UDP, 

SNMP, WINSOCK, and EXTERNAL. 

� SA_HOSTNAME – hostname of the entry. 

� SA_HOSTID – ID assigned to entry. 

� SA_UID – Unique ID assigned automatically to the entry by Servers 

Alive. 

Examples 

<SAIF SA_STATUS IS DOWN>help us please it's down</SAIF> 

<SAIF SA_STATUS IS DOWN AND SA_CHECK IS SQL>The SQL 

database is down, again.</SAIF> 

<SAIF SA_CHECK IS ORACLE OR SA_CHECK IS SQL>A 

database.</SAIF> 

<SAIF SA_CHECK IS URL OR SA_CHECK IS SERVICE OR 

SA_CHECK IS DISKSPACE AND SA_STATUS IS DOWN>Big alert. 

Houston we have a problem</SAIF> 

<SAIF SA_HOSTNAME IS www.domain.com AND SA_STATUS IS 

DOWN>Might wanna update the resume, pal.</SAIF> 
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The evaluation is always processed from left to right and case does not 
matter.  Also, you can include quotes around the values, but they are not 
necessary. 

If you would like additional information and a starter template, you can 
download a zip archive with helpful information from: 
http://www.woodstone.nu/salive/doc/template.zip 
(http://www.woodstone.nu/salive/doc/template.zip) 

If you choose to use the sort=check option in the sa_report tag, you can 
specify a custom priority for the various check types.  You edit the 
following registry entry and supply a string that lists the order of 
importance for all checks. 

HKEY_LOCALMACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\CheckTypeSortOrder (string)  

Ex.  Default is WIPXSRDUQONME 

(Winsock TCP (W) - Winsock UDP (I) - PING (P) - IPX Ping (X) - NT 
Service (S) - NT process (R) - Disk space (D) - URL (U) - SQL server 
(Q) - Oracle (O) - Netware (N) - SNMP (M) - External (E)) 

Additional features include the following tags used to filter, on the page, 
the entries that can be displayed based on their status.  

<sa_report sort= 
status=ALL,DOWN,UNAVAILABLE,UP,UNCHECHED> 

You can have one or more of the list. For example, status=DOWN,UP 
gives only the entries that are up or down. 

You can sort the entries with the page with the following tags. Sorting is 
always by group and then by the parameter that you give within the page. 

sort=HOSTID,UID,NAME (or 
HOSTNAME),CHECK,STATUS,PRETTYNAME,IP 

You can have one or more of the list; for example sort=name,check. 

Example Template 

<!--This is the header section.--> 

<BODY> 

<!--Here the current date and time variables are used--> 

<H4>Last check done on 
<sa_currentlongdate>&nbsp&nbsp&nbsp<sa_currentlongtime> 
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<!—Add in a comment that notes that Servers Alive generated the page.--
> 

<!-- Generator Servers Alive version <sa_version> via template....--> 

<p> 

 

<TABLE WIDTH="762" cellpadding="4"> 

<TR><TD WIDTH="32" align="center"><FONT face="verdana" 

size="2"><B>Up?</TD> 

<TD width="20" align="center"><FONT face="verdana" 

size="2"><B>ID</TD> 

<TD width="130" align="center"><FONT face="verdana" 

size="2"><B>Host</TD> 

<TD width="280" align="center"><FONT face="verdana" 

size="2"><B>Host Check</TD> 

<TD width="80" align="center"><FONT face="verdana" 

size="2"><B>Parameter</TD> 

<TD width="70" align="center"><FONT face="verdana" 

size="2"><B>Actual</TD> 

<TD width="145" align="center"><FONT face="verdana" 

size="2"><B>Time of Last Status Change</TD> 

</FONT> 

</TR> 

 

<!--The core section begins here.  It is repeated for every host on the 

page.--> 

<sa_report sort=status> 

 

<!--Use SAIF to change the color depending on whether the host is up or 
down.--> 

<tr bgcolor="<saif sa_status is down>ff0f00</saif><saif sa_status is 

up>dbdcaf</saif>"> 

 

<TD BGCOLOR="#ffffff"> 
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<!--Use SAIF to display the correct icon (not supplied with Servers 
Alive) 

 depending on the host condition.--> 

<SAIF SA_STATUS IS UP><img src="images/running.jpg"></SAIF> 

<SAIF SA_STATUS IS DOWN><img src="images/stop.gif"></SAIF> 

</TD> 

 

<TD WIDTH=20 BGCOLOR="#8fbc8f"> 

<!--Display Host ID with SA_HOSTID.--> 

<CENTER><FONT SIZE=2><sa_hostid></FONT></CENTER> 

</TD> 

 

<TD WIDTH="145"> 

<!--Display Pretty Name with SA_PRETTYNAME.--> 

<FONT FACE=verdana SIZE=1><sa_prettyname></FONT> 

</TD> 

 

<TD WIDTH="280"> 

<!--Display the type of check with SA_CHECKDESCRIPTION.--> 

<FONT FACE=verdana SIZE=1><sa_hostname> 
(<sa_checkdescription>)</FONT> 

</TD> 

 

<TD WIDTH="80"> 

<!--Display check parameters with SA_THRESHOLD.--> 

<FONT FACE=verdana 
SIZE=1><CENTER><sa_threshold></CENTER></FONT> 

</TD> 
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<TD WIDTH="70"> 

<!--Display the response time/data with SA_CHECKRESPONSE.--> 

<FONT FACE=verdana 
SIZE=1><CENTER><sa_checkresponse></CENTER></FONT> 

</TD> 

 

<TD WIDTH="175" valign="center" align="center"> 

<!--Display the time of the last status change with 
SA_STATUSCHANGETIME and SA_STATUSCHANGEDATE.--> 

<FONT FACE=verdana SIZE=1><sa_statuschangetime>, 
<sa_statuschangedate></FONT> 

</TD> 

</TR> 

 

<!--End of the core section.--> 

</sa_report> 

 

<!--Beginning of footer.--> 

</TABLE> 

 

<BR> 

 

<!--Display when the last check cycle occurred using 
SA_CURRENTLONGDATE 

and SA_CURRENTLONGTIME.--> 

<H4>Last check done on 
<sa_currentlongdate>&nbsp;&nbsp;&nbsp;<sa_currentlongtime> 

</BODY> 
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Default Page 

 

 

Servers Alive creates HTML pages, but does not serve the pages using 
the built-in web server. 

Publish This Web Page 

Click this check box to enable Servers Alive to create one or more HTML 
pages after every check cycle. 

Add 

Click to enter the name of a web page. 

Delete 

Click to delete a web page. 

Page Name 

Enter the page name for the resulting HTML page. The name must also 
include the directory in which the file is created. 

Template Based 

Click to define a template file.  

Template File 

Enter a file name to use as boiler plate for the log file. You can click the 
browse button and select a file. 

Header File 

Figure 23: Default Page 
(1) 
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Customize the web page by specifying a custom HTML header page. 
You must also specify both the name and directory for these two files. If 
you use this option, you must also specify a footer file. When creating the 
HTML page, Servers Alive copies the header, adds the Servers Alive grid 
to it, and appends the footer at the end. To publish this page on the 
Internet or intranet, you need a third-party web server.  

Footer File 

Enter the file to use as a footer. See the previous option for more 
information. 

Look 

Customize the contents of the grid created by Servers Alive. 

Technical 

Specifies that the grid contains the name, port number and pretty name.  

Manager 

Specifies that the grid contains the pretty name, but not the name and port 
number. 

Exclude Time Info 

Specify whether the grid includes the current status and the time/date that 
it detected that status. Click Yes or No. 

Upload It Via FTP 

Uploads the page to your web server with File Transfer Protocol (FTP). 
Click to enter the required information. 

FTP Server 

Enter the name of the FTP server. 

Remote Name 

Enter the name of the remote server.  

User Name 

Specify the user name if the page must reside on a remote computer that 
requires authentication before you can write on the computer’s disk.  

Password 

Specify the password. 

PASV 
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Specifies to use passive ftp. This mode works better when you are 
connecting through a firewall than the normal FTP connection mode.  

However, clicking this check box does not guarantee that PASV mode 
works for your connection. PASV causes some security risks, so some 
network administrators disable PASV mode on the server side. 

The upload of HTML pages can give a "Busy executing command" error 
when several files have to be uploaded.  By default Servers Alive waits 
100ms after the upload in order to give the socket the time to do a correct 
reset.  If this is too much or to little time, you can change the value via 
the registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\FTPSleepTime (dword) Max is 5000 (ms). 

If you decide not to use a template page, refer to the following 
information. 

For each of the different statuses that Servers Alive can display in the 
HTML pages, you can change the font type by adding or editing the 
following registry keys: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStart 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UpFontStop 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStart 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\DownFontStop 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStart 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceFontStop 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStart 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableFontStop 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStart 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedFontStop 

Servers Alive displays the last check time just before or just after the 
table with the hosts. This can be configured by adding or editing the 
following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\PlaceOfCheckTime (dword) 
0 is below the table, 1 is above the table 
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You change the default size of the columns by adding or editing the 
following registry values: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\HostColumn (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\StatusColumn (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\SmallStatusColumn (string) 

Example: "100" or "35%" or "AUTO"  
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To change the background color of the table of the generated HTML 
page, you must add or edit the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\TableBackground (string) 

Example: "#FF0000" or "Red"  

By default, Servers Alive generates <TABLE BORDER="1"> as 
beginning of the table with the entry’s statuses. Using the above table 
background property gives you the option to specify 
<TABLEBGCOLOR="tablebackground">. 

By adding or editing the following registry value you are now able to 
specify  <TABLE BGCOLOR="tablebackground" tableproperties>  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\TableProperties (string) 

If you want to see the number of times a host has been down since the 
last log filename change in the saved HTML file, you must add or edit the 
following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\Includedownstats (dword)  

with a value of 1 

Servers Alive can replace the words UP - DOWN - ... in the HTML page 
by icons. To do this you must add/edit the following registry values: 

�  HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UpIcon (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\DownIcon (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\MaintenanceIcon (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UncheckedIcon (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\UnavailableIcon (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\IncludeIcons (dword) when 1 the icons is 
substituted for the normal words. 

All the above registry settings can be used differently for all the pages 
that Servers Alive must generate.  

� The default page uses 
HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\ as the root for its registry keys.  
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� A web page with a display name of WebServers uses 
HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\HTMLPage\WebServers\ as the root for its registry keys. 
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WAP Page 

 

 

Servers Alive is the first monitoring platform to support alerting via WAP 
(wireless access protocol) pages.  If you have a cellular device that can 
view WAP pages, you can spot check your servers while on the road! 

Enable WAP Output 

Click the check box to enable this feature and enter settings on the dialog 
box. 

WAP alerting uses the concept of WML cards, which are similar to 
linked HTML pages, to allow you to choose the way you view Servers 
Alive’s current status.  There are four different page types that can be 

used.  

To enable one of the pages you type in a full file path, including file 

name, or you can click the button on the right side of each location box 

and browse to the correct location.   

All Hosts with Status (Small) 

Produces a page that shows only the host names and their status.  

All Hosts with Status (Large) 

Produces a page with an initial view showing the names of the hosts and 

their status, with a link to show their exact check description.  

Figure 24: WAP Page 
(1) 
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If you are using this option, the resulting WML file can become very 
big. If you encounter size problems within your browser, you can use 
the Only Down Hosts (Large) option to produce a WML file. Future 
versions of Servers Alive will provide more control over what host 
should be in which WML file. 

On some WML browsers, the size of a deck is limited. This is the 
compiled size of a deck, and, because there is no direct link between 
the size of the source WML file and the size of the compiled WML 
file, Servers Alive cannot limit the size of the source WML file. In 
addition, not all browsers have the same limit.  

Only Down Hosts (Small) 

Produces a page that shows only the host names of down servers and their 
status. 

Only Down Hosts (Large) 

Produces a page with an initial view showing the names of the down 
hosts and their status, with a link to show their exact check description.  

Upload It Via FTP 

Uploads the page to your server with File Transfer Protocol (FTP). Click 
to enter the required information. 

FTP Server 

Enter the name of the FTP server. 

Remote Name 

Enter the name of the remote server.  

User Name 

Specify the user name if the page must reside on a remote computer that 
requires authentication before you can write on the computer’s disk.  

Password 

Specify the password. 

PASV 

Specifies to use passive ftp. This mode works better when you are 
connecting through a firewall than the normal FTP connection mode.  

However, clicking this check box does not guarantee that PASV mode 
works for your connection. PASV causes some security risks, so some 
network administrators disable PASV mode on the server side. 
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If you want to store your WAP page on a remote server that requires 
authentication, you can use the following registry entries to supply the 
authentication information.  The server listed here should be the same as 
the server listed in the GUI for WAP file storage. 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\WAP\Username (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\WAP\Password (string) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\WAP\Server (string) 

The upload of WAP pages can give a "Busy executing command" error 
when several files have to be uploaded.  By default, Servers Alive waits 
100ms after the upload in order to give the socket the time to do a correct 
reset.  If this is too much or to little time, you can change the value in the 
registry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\WAP\FTPSleepTime (dword) Max is 5000 (ms). 

Servers Alive does not provide any WAP access through its built-in web 
server. It only generates WML files that can be viewed via a WML 
enabled browser, typically a WAP-enabled phone, through a third-party 
web server.  

If you want to publish WML files with your own web server, you must 
add the needed MIME type to your web server.  Some WML browsers 
need those to be able to show the downloaded WML files. 

You will need the following: 

� Associated extension: WML 

� Content type (MIME):  text/vnd.wap.wml 

 
 

General 

The General settings for Setup include the following: 

� Proxy settings 

� Startup settings 

� And various settings for the individual user. 
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Proxy Settings 

 

 

In Servers Alive, you can set up two different sets of proxy settings. You 
can configure the following settings for two proxy servers.  

Proxy Server 

Depending on your setup, you can require Servers Alive to do some or all 
URL type checks through a proxy for security purposes. You can force 
this behavior by specifying a server and port in this section. You can 
enter either the domain name or IP address of the server. Just entering 
information in this section of the Setup dialog box does not force all URL 
checks to go through the proxy. You must still enable the use of proxy on 
specific entries. 

Server Name 

Enter the name of the proxy server. 

Port 

Enter the port for the proxy server. 

Use Proxy Authentication 

Click to enable proxy authentication. 

User Name 

Enter the user name. 

Password 

Figure 25: Proxy 
Settings (2) 
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Enter the password. 

Use NTLM Proxy Authentication 

Enables NT LAN Manager (NTLM) Authentication. This allows you to 
authenticate via an MS Proxy Server using the proprietary NTLM 
protocol. 
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Startup Settings 

 

 

The Startup Settings branch of the Setup dialog box tree controls how 
Servers Alive gets its list of monitored services and what the software 
does with them initially. 

Load Startup Info from Registry 

Click if you plan to have Servers Alive start up automatically and read in 
a saved list of monitored entries, which is required for operation as a 
service. In the registry, Servers Alive stores the various startup options 
and the name of the file containing information on what entries to check. 

Hostfile 

Specify where the saved file containing check information is located. 
This file has not been created yet if you are reading through this 
documentation for the first time, so you must refer to this information 
again later, after you have created your list of entries. 

Start Checking But Wait __ Seconds After the Start of the Program 

Click the check box to enable Servers Alive to automatically start 
checking when it is launched.  Enter the number of seconds that you want 
to make Servers Alive pause before checking. This is useful if Servers 
Alive runs as a service when the computer boots up, but you want Servers 
Alive to wait for all local programs to finish launching before starting its 
check cycle.   

Don’t Cache IP Addresses 

Figure 26: Startup 
Settings (2) 
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Click to ensure that Servers Alive does not cache the IP addresses. By 
default, the first time Servers Alive checks a host, the software resolves 
the name into an IP address. Each of the following times Servers Alive 
checks your host, the software uses the IP address stored in memory.  

Finally, at the bottom you can decide whether Servers Alive uses minutes 
or seconds as its cycle unit  This time unit determines how long Servers 
Alive  waits between check cycles, which is set on the Misc branch (on 
page 82) of the Setup tree. 

Start Minimized 

Starts Servers Alive minimized, whether the software is launched through 
the Programs menu or as a service. 

Only Show Pretty Name in GUI 

Shows only the pretty names in the software interface. Pretty names are 
labels that you assign to your monitored items for easy recall. 

Other Startup Options 

Cycle Unit 

Determines whether Servers Alive uses minutes or seconds as the cycle 
unit This time unit determines how long the software waits between 
check cycles. You can specify settings for the check cycle on the Misc 
Settings branch of the Settings dialog box tree. 

Send Mail at Start/Stop of Checking 

Click this check box to enable Servers Alive to send mail at the beginning 
and ending of every check cycle. 

List of Public Holidays 

Enter a list of public holidays. You must use the dd-mm-yy format with a 
comma delimiter. For example, you can enter 12-25-03 for December 25, 
2003. 

You can use the Startup branch of the Setup tree to edit your list of public 
holidays. These public holidays can be treated as a Sunday, rather than 
whatever day they actually fall on, when Servers Alive determines whom 
to alert. You turn that feature on when defining a person with the Edit > 
People command. 
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Misc Settings 

 

 

Automatically Save Changes to a File 

Click to save changes to a file. If the Automatically save changes to a file 
option is enabled, all changes made to the current entries configuration 
are saved automatically. If the option is enabled and you start a new set of 
entries, you are prompted for a file name when you exit Servers Alive.  

Load Windows Positions at Startup 

Select to open Servers Alive in the same size and position that it had 
when you closed the software. If Load window positions at startup is 
enabled, Servers Alive restores its last position on the screen and also 
restores itself to the last known window size.  

Send Keep Alive Mails Every __ Minutes 

Enter the number of times that you want mails sent. You can request a 
mail from Servers Alive every once-in-awhile as proof that it is still 
running. 

Automatically Restart Checking After __ Minutes 

Specify how often you want Servers Alive to start checking in minutes. 

Check Times (Every X Minutes) 

Enter values in the grid to tell Servers Alive when to begin a check cycle 
on your list of hosts. If the value is 0 (zero), no checking is completed in 
that time period.  Saturday 6pm to 8am means from Saturday 6pm to 
Sunday 8am. The same logic holds for all others.  

Figure 27: Misc Settings 
(2) 
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Weekday 

Saturday 

Sunday 

By default the morning starts at 8h (8AM) and the evening starts at 18h 
(6PM). You can change this by adding or editing the following registry 
entries: 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\MorningStart (dword) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\EveningStart (dword) 

Times are in 24h format. 6pm would be 18. 

You can use the Startup branch of the Setup tree to edit your list of public 
holidays. These public holidays can be treated as a Sunday, rather than 
whatever day they actually fall on, when Servers Alive determines whom 
to alert. You turn that feature on when defining a person with the Edit > 
People (on page 205) command. 
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Built-in Servers 

Servers Alive has several built-in servers to include:  

� Web server 

� Telnet server 

� SSH server 

� SNMP server 

You can use these to remotely determine the status of all checked items 
and issue some basic management commands (on page 91). 

The difference between SSH and Telnet communications are:  

� Communication between a telnet client and a telnet server is clear 
text.  

� Communication between an SSH client and an SSH server is 
encrypted. 
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Web Server 

 

 

Enable Web Server (HTTP) 

Click to enable the web server. If you enable the built-in web server, it 
publishes a standard status page on the port you designate.  

This web page cannot be altered beyond a few cosmetic changes.  If you 
need to have a more detailed web page, or desire a different layout, please 
refer to the HTML Page (on page 62) section. Note that the options in the 
HTML Page branch do not apply to the built-in web server.  

Web Server Port Number 

Specify the port number for the server. The default is 4310. 

Enable Automatic Web Page Update 

Click to allow automatic updates to the web page. The web page causes 
the browser to refresh itself every minute for an up-to-date view of the 
current checked status of all items.   

Note that this web page does not include any management options and is 
not password protected.  If you need this sort of functionality, you must 
use a third party web server. 

You can use the following registry key to change the automatic update 
interval of the built-in web server; the default is 60 seconds: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\AutoUpdateHTTPInterval (string) 

In some cases, you might need to adjust the HTTP output buffer to 
improve the speed. You can do this by creating the following registry 
key: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBUConsulting\Servers 
Alive\StartUp\HTTPDaemon_OutBufferSize (string) 

The default value is 999999. 
 

Figure 28: Built-in 
Servers (1) 
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Telnet Server 

 

 

Enable Telnet Server 

Click to enable a Telnet server. If you enable the Telnet server and 
specify a port number,  you can interrogate Servers Alive via a Telnet 
client, which comes with Windows. With a Telnet client, you can see a 
list of all hosts, their status, and the last time the status changed. The list 
is ordered by status. The Telnet server supports multiple connections. 

Telnet Server Port Number 

Enter the port number of the Telnet server. The default port number is 
4301.  

Maximum Number of Concurrent Connections 

Enter the maximum number of concurrent connections. 

Echo Back to Telnet Client 

Click the check box to enable Telnet character echo. By default, this 
feature is not turned on. This means that what you type might not be 
visible on the screen as you type it, depending on the client you use and 
how it is configured.   

You can also issue some commands that modify the behavior of Servers 
Alive. Refer to the Commands (on page 91) section for a list of 
commands that the Telnet server understands. 
 

Figure 29: Telnet Server 
(1) 
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Security 

 

 

You can provide some security to the built-in Telnet server so that only 
approved personnel can issue administrative commands.  You do this by 
clicking the branch Security of the Setup tree. The types of security that 
you can add to a Telnet server are IP address restrictions or password 
protection. 

IP Address Access Restrictions 

By Default Computers will be 

Secures the Telnet server by allowing only certain IP addresses to 
connect.  You can choose from two basic modes.   

Granted Access 

Permits all computers to access the Telnet server.   

Denied Access 

Restricts access to all computers. If you select this option, you can add 
exceptions to the rule. The usual procedure is to deny everyone access by 
default and then add in certain exceptions, by IP address, for known good 
addresses. To add an IP address range, specify an appropriate subnet 
mask. 

Except Those Listed Below 

Lists exceptions to the computers that are denied or permitted access to 
the Telnet server, depending on the option that you selected in By Default 
All Computers Will Be.  

Access  

Figure 30: Security (1) 
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Displays whether the specific IP address is denied or permitted access to 
the Telnet server. 

IP Address 

Lists the IP address of each computer that is denied or permitted access to 
the Telnet server. 

Add 

Click to add an IP address to the list. 

Remove  

Select an IP address and then click Remove to delete the address from the 
list of exceptions. 

Edit 

Select an IP address and then click Edit to change the address. 

Password Protection 

Sets password protection, the other type of access restrictions for Telnet 
servers. Choose Password protected (Full-control) or Password Protected 
(Read-only).  You can have two log-in names: one name that has full 
control and one that can only retrieve the status of checked hosts.   

If you use this type of authentication, remember that the Telnet 
protocol does not make use of any encryption.  Any user name and 
password that you use goes out over the network in clear text and can 
be intercepted.  Plan accordingly.  Note that you can use both types of 
security simultaneously. 

Password Protected (Full-Control) 

Allows a name and password for a user who has full control. 

User Name 

Enter the name of the user with full control. 

Password 

Enter the password of the user with full control. 

Password Protected (Read-Only) 

Allows a name and password for a user who can only retrieve the status 
of checked hosts. 

User Name 
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Enter the name of the user with read-only privileges. 

Password 

Enter the password of the user with read-only privileges. 
 

Access Restrictions 

 

 

You can set access restrictions by entering an IP address and subnet mask 
for Telnet servers, SSH servers, or SNMP trap receivers. 

You can open this dialog box by selecting the following items in the 
Main Window: 

� File > Setup > Tree: Built-in Servers > Telnet Server > Security > Add 
button 

� File > Setup > Tree: Built-in Servers > SSH Server > Security > Add 
button 

� File > Setup > Tree: Built-in Servers > SNMP Trap Receiver > Add 
button 

 

Figure 31: 
AccessRestrictions (1) 
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Commands 

RELEASE IP 

Internally Servers Alive converts all host names into IP addresses the first 
time they are used.  This goes for the hosts you check as well as any 
SMTP servers that you use. If you want to release all of these IP 
addresses from memory while Servers Alive is running, you can do this 
with the RELEASE IP command on the Telnet interface. 

START CHECKING 

Accomplishes the same action as clicking the Start button on the Main 
window of Servers Alive. 

STOP CHECKING 

Accomplishes the same action as clicking the Stop button on the Main 
window of Servers Alive. 

SYST 

Shows the build number of Servers Alive. 

STATUS 

Shows a list of all hosts and their current status. 

STATUS DOWN 

Shows a list of all hosts in a down state. 

STATUS MAINTENANCE 

Shows a list of all hosts in a maintenance state. 

QUIT 

Disconnects your Telnet client from the Telnet interface of Servers Alive. 

HELP 

Displays some very basic help on various Telnet commands. 

UPDATE 

Accomplishes the same action as clicking the UPDATE button on the 
main screen of Servers Alive. 

MAINTENANCE x 

Sets host x into maintenance mode. To get the number of the host issue a 
STATUS command and you will see the number of all hosts. 
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MAINTENANCE ALL 

Sets all hosts into maintenance mode. 

ACTIVE x 

Sets host x into active mode. To get the number of the host, issue a 
STATUS command and you will see the number of all hosts. 

ACTIVE ALL 

Activates all hosts. 

LOAD filename 

Accomplishes the same action as clicking File > Open from the Main 
window of Servers Alive. 

RESET PAGER 

Clears all pager queues. 

RESET DOWN COUNTERS 

Resets all down counters for all hosts. 

RESET STATISTICS 

Resets the statistics of all hosts. 

SET ALL SOUND TO NONE 

Sets all sound entries to none. 

SET ALL SOUND TO DEFAULT 

Sets all sound entries to default, used most often when you add a sound 
card to your computer after you have configured Servers Alive. 

SET ALL PRIMSMTPMESSAGE TO xyz 

Sets all primary SMTP messages to xyz. 

SET ALL ALTSMTPMESSAGE TO xyz 

Sets all alternate SMTP messages to xyz. 

ENABLE TEAM=<name of team> 

Enables the named team. 

DISABLE TEAM=<name of team> 

Disables the named team. 
 



 

 File Menu 93 

 

SSH Server 

 

 

Enable SSH Server 

Click to enable a SSH server. If you enable the SSH server and specify a 
port number,  you can interrogate Servers Alive with a SSH client, which 
comes with Windows. With a SSH client, you can see a list of all hosts, 
their status, and the last time the status changed. The list is ordered by 
status. The SSH server supports multiple connections. 

SSH Server Port Number 

Enter the port number of the SSH server. The default port number is 
4322.  

Maximum Number of Concurrent Connections 

Enter the maximum number of concurrent connections. 

Echo Back to SSH Client 

Click the check box to enable SSH character echo. By default, this 
feature is not turned on. This means that what you type might not be 
visible on the screen as you type it, depending on the client you use and 
how it is configured.   

You can also issue some commands that modify the behavior of Servers 
Alive. Refer to the Commands (on page 91) section for a list of 
commands that the SSH server understands. 
 

Figure 32: SSH Server 
(1) 
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Security 

 

 

You can provide some security to the built-in SSH server so that only 
approved personnel can issue administrative commands.  You do this by 
clicking the branch of the Setup tree labeled Security. The types of 
security that you can add to a SSH  server are IP address restrictions or 
password protection. 

IP Address Access Restrictions 

By Default Computers will be 

Secures the SSH server by allowing only certain IP addresses to connect.  
You can choose from two basic modes.   

Granted Access 

Permits all computers to access the SSH server.  

Denied Access 

Restricts access to all computers. If you select this option, you can add 
exceptions to the rule. The usual procedure is to deny everyone access by 
default and then add in certain exceptions, by IP address, for known good 
addresses. To add an IP address range, specify an appropriate subnet 
mask. 

Except Those Listed Below 

Lists exceptions to the computers that are denied or permitted access to 
the SSH server, depending on the option that you selected in By Default 
All Computers Will Be.  

Access  

Figure 33: Security (2) 



 

 File Menu 95 

 

Displays whether the specific IP address is denied or permitted access to 
the SSH server. 

IP Address 

Lists the IP address of each computer that is denied or permitted access to 
the SSH server. 

Add 

Click to add an IP address to the list. 

Remove  

Select an IP address and then click Remove to delete the address from the 
list of exceptions. 

Edit 

Select an IP address and then click Edit to change the address. 

Password Protection 

Sets password protection, the other type of access restrictions for SSH 
servers. Choose Password protected (Full-control) or Password Protected 
(Read-only).  You can have two log-in names: one name that has full 
control and one that can only retrieve the status of checked hosts.   

If no password protection is selected, then Servers Alive uses the 
following security settings: 

� FULL CONTROL password protected 

� Username: sshuser 

� Password: sshpassword 

Password Protected (Full-Control) 

Allows a name and password for a user who has full control. 

User Name 

Enter the name of the user with full control. 

Password 

Enter the password of the user with full control. 

Password Protected (Read-Only) 

Allows a name and password for a user who can only retrieve the status 
of checked hosts. 

User Name 

Enter the name of the user with read-only privileges. 
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Password 

Enter the password of the user with read-only privileges. 
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SNMP Trap Receiver 

 

 

Enable SNMP Trap Receiver 

Click to enable Simple Network Management Protocol (SNMP) traps. 

SNMP Trap Receiver Port Number 

Enter the port number of the SNMP trap receiver. The default port 
number is 162.  

Maximum Number of Traps to Save 

Enter the maximum number of traps to receive. 

IP Address Access Restrictions 

By Default Traps from All Computers will be 

Secures the SNMP trap receiver by allowing only certain IP addresses to 
connect.  You can choose from two basic modes.   

Accepted 

Permits all computers to access the SNMP receiver.  

Denied 

Restricts access to all computers. If you select this option, you can add 
exceptions to the rule. The usual procedure is to deny everyone access by 
default and then add in certain exceptions, by IP address, for known good 
addresses. To add an IP address range, specify an appropriate subnet 
mask. 

Figure 34: SNMP Trap 
Receiver (1) 
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Except Those Listed Below 

Lists exceptions to the computers that are denied or permitted access to 
the SNMP Receiver, depending on the option that you selected in By 
Default Traps from All Computer will be.  

Access  

Displays whether the specific IP address is denied or permitted access to 
the SNMP receiver. 

IP Address 

Lists the IP address of each computer that is denied or permitted access. 

Add 

Click to add an IP address to the list. 

Remove  

Select an IP address and then click Remove to delete the address from the 
list of exceptions. 

Edit 

Select an IP address and then click Edit to change the address. 
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On the Edit menu in the Main window, you can complete the following 
activities: 

� Quickly locate an entry. 

� Edit entries, to include settings for checks and alerts. 

� Add new entries based on another entry 

� Find and replace various settings, such as your pager number. 

� Edit teams, people, and protocols. 

In This Chapter 

Find.................................................................................... 101 
Entries................................................................................ 103 
New Entry Based On . . . ................................................... 193 
Import Hosts ...................................................................... 195 
Edit .................................................................................... 197 
Delete................................................................................. 199 
Delete All........................................................................... 201 
Global Change (Replace)................................................... 203 
People ................................................................................ 205 
Teams................................................................................. 215 
People and Teams Example............................................... 217 
Protocols ............................................................................ 221 
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Find 

In a long list of hosts, you can click Edit > Find on the Main window to 
quickly locate a specific entry.   

 

 

Find What 

Enter the pretty name of the entry and then click OK. 

 
 

Figure 35: Find (1) 
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Entries 

Once Servers Alive has been configured properly, you are ready to begin 
adding or editing entries.  When adding or editing an entry, a dialog box 
appears that allows you to specify what host should be checked and what 
should be checked on that host.   

You can add new entries by clicking the Add button.  You can edit entries 
by either selecting an entry and clicking the Edit button or double-
clicking an entry, when the software is not in a check cycle. 

If you have purchased the Standard version, you can create up to 1000 
entries. If you have purchased the Enterprise edition, you can create up to 
5000 entries. 

 

 

 

 
 

Figure 36: Entries (1) 
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General 

 

 

Server Name of IP(X) Address 

Enter the name of the server or its IP address. You can enter a NetBIOS 
name (server) or its fully qualified domain name (server.domain.com). 
Internally Servers Alive attempts to resolve this name to the name’s IP 
address on its first check cycle and then use that address from then on.  If 
the software has trouble resolving a name, you might need to specify the 
host by IP address. For an IPX ping, you must enter the IPX address of 
the server. If you enter an IPX address, enter the network address, a colon 
<:>, and then the node address; for example: 352FBA2B:000000000001. 

Pretty Name 

Enter the pretty name. The pretty name is used only for display purposes, 
such as in the software, Telnet client, e-mail, HTTP/HTML output, and 
so forth.  You should enter a descriptive name that instantly identifies the 
computer and check to you when you receive it in a page or e-mail. 

Host ID 

Enter the number used to identify the host when using numeric paging 
and in the interchange format.  You do not need to enter anything in this 
field, as it is automatically generated for you when you create the entry.  
You can change the host ID to be more meaningful for you, however. 

Include This Entry in the Check Option 

Figure 37: General (1) 
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Click the check box to include the entry in the check. If a host is down 
due to maintenance, you can exclude it temporarily from the list of hosts 
that is checked. The HTML report shows the host as being in 
MAINTENANCE.  The fastest way to do this is in the Main window of 
Servers Alive.  You can select the entry, right-click on it, and then choose 
Maintenance on the shortcut menu.  You can also place a host in 
maintenance mode with the Telnet server. 

Depends On 

Select a server name from the list. 

Being 

Select the status of the server for when you want the check to occur. 

Group Membership 

Select the group. 

Remark 

Enter a note or remark for your reference. 

By default, Servers Alive connects to the host using the Normal LAN 
connection (__LAN__), but Servers Alive can also create a dial-up 
connection to an external network before completing the check. After the 
check, Servers Alive disconnects from the external network. 

This feature is available only if DUN (Dial-up Networking) is installed 
on the computer running Servers Alive.  To use this feature effectively, 
Servers Alive must make the connection completely unattended.  For that 
reason, you must have the dial-up entry save passwords. 

Connect Via 

Select an item from the list to select how you want to connect. Click the 
Configure button to change settings for the item that you selected. 

Configure  

Click to configure the item that you select in the Connect Via list. 

Keep Connection Active 

Click the check box to keep the connection active after the check is 
completed. 
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Check 

 

 

After supplying the needed information for the General tab of the Entries 
dialog box, you must select what type of check to use for the entry on the 
Checks tab.  You can choose from many check options. 

Only one check can be used for each entry on the Main window.  If you 
want to perform multiple checks on a server, you must have separate 
entries for each check you want.  Each check type is discussed in the 
following sections. 

The Winsock checks include any checks that make a basic connection to 
another computer over TCP/IP.  This includes both TCP and UDP 
connections.  TCP checks are used for things such as web and mail 
servers.  UDP checks include things such as Radius servers, DNS servers, 
and various game servers.  Servers Alive can also monitor CITRIX®  

Terminal Servers with the UDP protocol. 

When creating a check, first select the protocol that applies to the check 

type you want by selecting the appropriate item in the Check to Use list.  

You can select from any of the protocols that Servers Alive supports: 

� TCP 

� UDP 

� DNS 

� Radius 

� Ping 

� NT Service, Process, and Perfmon 

� Diskspace 

� URL (HTTP/HTTPS and RTSP/MMS) 

Figure 38: Check (1) 
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� Database (Microsoft SQL and Oracle) 

� Netware 

� SNMP 

� External COM 

� External (Errorlevel)  

While verifying that a port is open can be sufficient to monitor a service, 
this can also cause odd logging on whatever server is being checked.  
Some services, such as SSH, do not function properly when computers 
connect and then immediately disconnect.  For this reason, you might see 
spurious warnings in the logs regarding connections from the Servers 
Alive Server. This is not a problem, but it is something you should keep 
in mind. 
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TCP Protocol 

 

 

You can define your own protocol and the corresponding port by clicking 
Edit > Protocol (on page 221) in the Main window.  

Check to Use 

Select the protocol that you want to use.  

Next, select the specific port or service you want to check.   

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive 
defines these, along with their default ports. 

Other 

Click this option if you want to check a TCP service that is not on the list 
or is using a non-standard port. You must then supply the port number. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Figure 39: Check (1) 
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Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
 



 

 Edit Menu 111 

 

UDP Protocol 

 

 

Servers Alive supports checks for common game servers including the 
following: 

� Quake1, QuakeWorld Master, Quake 2, Quake 2 Master, Quake 3,  

� Half-Life, Half-Life Master,  

� Tribes, Tribes Master, Tribes 2,  

� Unreal, Unreal Master,  

� Hexen World, and Hexen 2.   

Thanks to Carl at www.dnagames.net (www.dnagames.net) for providing 
the information needed to provide the game server checks. 

You can define your own protocol and the corresponding port by clicking 
Edit > Protocol (on page 221) in the Main window.  

Check to Use 

Select the protocol that you want to use. 

Next, select the specific port or service you want to check.   

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive 
defines these, along with their default ports. 

Other 

Figure 40: UDP 
Protocol (1) 
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Click this option if you want to check a TCP service that is not on the list 
or is using a non-standard port. You must then supply the port number. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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DNS Protocol 

 

 

You can define your own protocol and the corresponding port by clicking 
Edit > Protocol (on page 221) in the Main window.  

Check to Use 

Select the protocol that you want to use. 

Next, select the specific port or service you want to check.   

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive 
defines these, along with their default ports. 

Other 

Click this option if you want to check a TCP service that is not on the list 
or is using a non-standard port. You must then supply the port number. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Figure 41: DNS Protocol 
(1) 
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Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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Radius Protocol 

 

 

You can define your own protocol and the corresponding port by clicking 
Edit > Protocol (on page 221) in the Main window.  

Check to Use 

Select the protocol that you want to use. 

Next, select the specific port or service you want to check.   

On Port 

Default 

Click to use the default, or most common, ports or services. Servers Alive 
defines these, along with their default ports. 

Other 

Click this option if you want to check a TCP service that is not on the list 
or is using a non-standard port. You must then supply the port number. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Figure 42: Radius 
Protocol (2) 
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Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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Ping 

 

 

Check to Use 

Select the protocol that you want to use. 

IP Ping 

Click to enable the ping feature. Servers Alive can ping a host using an 
ICMP network frame, which determines if the computer and the network 
between the computer and the Servers Alive computer are functional. 

Servers Alive can also ping over the IPX protocol for Novell servers and 
clients. Servers Alive uses the functionality of the Novell Netware client 
for that, which you must install separately.  

A ping (IP) can generate the following error codes, which can be found in 
the log files: 

� IP_SUCCESS = 0 

� IP_BUF_TOO_SMALL = (11001) 

� IP_DEST_NET_UNREACHABLE = (11002) 

� IP_DEST_HOST_UNREACHABLE = (11003) 

� IP_DEST_PROT_UNREACHABLE = (11004) 

� IP_DEST_PORT_UNREACHABLE = (11005) 

� IP_NO_RESOURCES = (11006) 

� IP_BAD_OPTION = (11007) 

� IP_HW_ERROR = (11008) 

� IP_PACKET_TOO_BIG = (11009) 

Figure 43: Ping (3) 
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� IP_REQ_TIMED_OUT = (11010) 

� IP_BAD_REQ = (11011) 

� IP_BAD_ROUTE = (11012) 

� IP_TTL_EXPIRED_TRANSIT = (11013) 

� IP_TTL_EXPIRED_REASSEM = (11014) 

� IP_PARAM_PROBLEM = (11015) 

� IP_SOURCE_QUENCH = (11016) 

� IP_OPTION_TOO_BIG = (11017) 

� IP_BAD_DESTINATION = (11018) 

Send ___ Frames, Of Which at Least ___ % Must Respond with the Timeout 

Enter the number of frames and percentage that must respond within the 
timeout limit that you set. 

The IPX Ping and IPX Diagnostic Ping options are available if the Novell 
Netware client is installed and if the host name is entered as an IPX 
address. Example:  352FBA2B:000000000001). 

IPX Ping 

Click to use socket 9086. 

IPX Diagnostic Ping 

Click to use socket 456. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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NT Service 

 

 

Servers Alive can perform various checks specific to Windows NT and 
2000.  It can check NT services on local and remote computers.  Keep in 
mind that if you are running Servers Alive as a service, and want to check 
a service, process, or performance counter on a remote computer, you 
must specify a user name and password with sufficient rights to perform 
the check on the remote computer.   

In order for Servers Alive to perform the various Windows NT/2000 
specific checks, it must have access to the remote server’s NetBIOS 

ports.  This can be a problem if there are any intervening firewalls.  

Please consult with your firewall administrator to get the required access, 

if this is the case. 

NT services can be checked from a Windows 98 computer if the NT 

administration tools are installed on the computer and are available to 

Servers Alive. The process works best if the tools are installed in the 

same directory as Servers Alive.  

Check to Use 

Select the protocol that you want to use. Servers Alive checks to see if a 

service is running. 

Check 

Click this radio button and then click the browse button to open the 

Services Running On Dialog Box (on page 121). You can then select 
from the list of services running on the remote computer. 

Authenticate Before Checking  

Figure 44: NT Service 
(1) 
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Click to enable authentication before the check starts.  

The user performing the service check needs to have at least power-user 
rights on the computer that is checked. For the process checking you need 
administrator rights. This means that, when Servers Alive runs within the 
context of user_1, user_1 must have power-user or administrator rights on 
the computer that is checked.  

If user_1 does not have sufficient rights, you can specify another user 
name, usually in the form domain\username, and password of a user with 
power-user or administrator rights on the computer that is checked.  

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 

The various Windows checks can return errors in the log.  Some common 
errors follow: 

� 5  Access denied. 

� 53  The network path was not found. 

� 1219   Multiple connections to a server or shared resource by the 
same user, using more than one user name, are not allowed. 
Disconnect all previous connections to the server or shared resource 
and try again. 

� 1220  An attempt was made to establish a session to a network server, 
but there are already too many sessions established to that server. 

� 1312  A specified log on session does not exist.  It might already be 
terminated. 

� 1322   No mapping between account names and security IDs was 
completed. 

� 1323  The value provided as the current password is incorrect. 

� 1324 The value provided contains values that are not allowed in 
passwords. 

� 1325 The value provided does not meet the length, complexity, or 
history requirement of the domain. 
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� 1326 Unknown user name or bad password. 

� 1327 User account restriction. 

� 1328 Account logon time restriction violation. 

� 1329 User not allowed to log on to this computer. 

� 1330 The specified account password has expired. 

� 1331 Account currently disabled. 

�  1722 The RPC server is unavailable. 

Normally Servers Alive de-authenticates at the end of any check cycle 
that incorporates authentication.  If for some reason this does not succeed, 
it can cause any subsequent checks to fail.  To force an authentication 
disconnect before a check, add the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword).  
Value of 1 turns this feature on. 

If any error code found within this comma separated list occurs during 
the authentication phase, Servers Alive still sees the authentication as 
being successful. This is not a guarantee that the check as such will pass 
too. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 
 

 

When you use an NT Service check, you can select an item to check, 
such as Audiosrv <=> Windows Audio. 

To open this dialog box, select the following items from the Main 
window: 

� Add button > Entries dialog box > Check tab > Check to Use list: NT 
Service > Browse button. 
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NT Process 

 

 

Servers Alive can perform various checks specific to Windows NT and 
2000.  It can check NT process on local and remote computers.  Keep in 
mind that if you are running Servers Alive as a service, and want to check 
a service, process, or performance counter on a remote computer, you 
must specify a user name and password with sufficient rights to perform 
the check on the remote computer.   

Servers Alive can only check for Windows NT processes if Servers Alive 
is running on a computer that runs Windows NT or Windows 2000.  

In order for Servers Alive to do the various Windows NT/2000 specific 
checks, it must have access to the remote server’s NetBIOS ports.  This 

can be a problem if there are any intervening firewalls.  Please consult 

with your firewall administrator to get the required access, if this is the 

case. 

If you select NT process, you can click List the Available to get a list of 

the running processes on the remote computer.  Double-click on one to 

select it and return to the check dialog box.  On the right side, select the 

check condition.  Servers Alive can alert you when there is less than or at 

least x number of the specified processes running.  This is commonly 

used to alert when the Dr. Watson process is running (indicating an 

error). 

Check to Use 

Select the protocol that you want to use. 

Check 

Figure 45: NT Process 
(1) 
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Click this radio button and then click the browse button to open the 
Processes Running On Dialog Box (on page 125). You can then select 
from the list of services running on the remote computer. 

And Alert When ____ ____ Instances Are Running 

Enter the condition and number of instances to perform the check. 

Authenticate Before Checking  

Click to enable authentication before the check starts.  

The user performing the service check needs to have at least power-user 
rights on the computer that is checked. For the process checking you need 
administrator rights. This means that, when Servers Alive runs within the 
context of user_1, user_1 must have power-user or administrator rights on 
the computer that is checked.  

If user_1 does not have sufficient rights, you can specify another user 
name, usually in the form domain\username, and password of a user with 
power-user or administrator rights on the computer that is checked.  

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 

The various Windows checks can return errors in the log.  Some common 
errors follow: 

� 5  Access denied. 

� 53  The network path was not found. 

� 1219   Multiple connections to a server or shared resource by the 
same user, using more than one user name, are not allowed. 
Disconnect all previous connections to the server or shared resource 
and try again. 

� 1220  An attempt was made to establish a session to a network server, 
but there are already too many sessions established to that server. 



 

124 Servers Alive User’s Guide 

 

� 1312  A specified log on session does not exist.  It might already be 
terminated. 

� 1322   No mapping between account names and security IDs was 
completed. 

� 1323  The value provided as the current password is incorrect. 

� 1324 The value provided contains values that are not allowed in 
passwords. 

� 1325 The value provided does not meet the length, complexity, or 
history requirement of the domain. 

� 1326 Unknown user name or bad password. 

� 1327 User account restriction. 

� 1328 Account logon time restriction violation. 

� 1329 User not allowed to log on to this computer. 

� 1330 The specified account password has expired. 

� 1331 Account currently disabled. 

�  1722 The RPC server is unavailable. 

Normally Servers Alive de-authenticates at the end of any check cycle 
that incorporates authentication.  If for some reason this does not succeed, 
it can cause any subsequent checks to fail.  To force an authentication 
disconnect before a check, add the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword).  
Value of 1 turns this feature on. 

If any error code found within this comma separated list occurs during 
the authentication phase, Servers Alive still sees the authentication as 
being successful. This is not a guarantee that the check as such will pass 
too. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 
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When you use an NT Process check, you can select an item to check such 
as Idle, System, or Winlogon. 

To open this dialog box, select the following items from the Main 
window: 

� Add button > Entries dialog box > Check tab > Check to Use list: NT 
Process > Browse button. 
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NT Perfmon 

 

 

Servers Alive can perform various checks specific to Windows NT and 
2000.  It can check NT performance counters on local and remote 
computers.  Keep in mind that if you are running Servers Alive as a 
service, and want to check a service, process, or performance counter on 
a remote computer, you must specify a user name and password with 
sufficient rights to perform the check on the remote computer.   

In order for Servers Alive to do the various Windows NT/2000 specific 
checks, it must have access to the remote server’s NetBIOS ports.  This 

can be a problem if there are any intervening firewalls.  Please consult 

with your firewall administrator to get the required access, if this is the 

case. 

Check to Use 

Select the protocol that you want to use. 

Check 

Click this radio button and then click the browse button to open the Select 
Counter Dialog Box (on page 129). You can then select from the list of 

services running on the remote computer. 

Authenticate Before Checking  

Click to enable authentication before the check starts.  

Figure 46: NT Perfmon 
(1) 
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The user performing the service check needs to have at least power-user 
rights on the computer that is checked. For the process checking you need 
administrator rights. This means that, when Servers Alive runs within the 
context of user_1, user_1 must have power-user or administrator rights on 
the computer that is checked.  

If user_1 does not have sufficient rights, you can specify another user 
name, usually in the form domain\username, and password of a user with 
power-user or administrator rights on the computer that is checked.  

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 

The perfmon check sometimes fails (or gives weird values) due to timing 
issues with the performance counters retrieval DLL. By default the 
timeout is set to 1000ms, you can change it by creating the following 
registry entry and giving it a value between 1 and 10000 (milliseconds).  
Remember it is in ms and the default is already 1000, so you should try it 
with numbers higher than 1000. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\PerfmonTimings (string) 

The various Windows checks can return errors in the log.  Some common 
errors follow: 

� 5  Access denied. 

� 53  The network path was not found. 

� 1219   Multiple connections to a server or shared resource by the 
same user, using more than one user name, are not allowed. 
Disconnect all previous connections to the server or shared resource 
and try again. 

� 1220  An attempt was made to establish a session to a network server, 
but there are already too many sessions established to that server. 

� 1312  A specified log on session does not exist.  It might already be 
terminated. 
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� 1322   No mapping between account names and security IDs was 
completed. 

� 1323  The value provided as the current password is incorrect. 

� 1324 The value provided contains values that are not allowed in 
passwords. 

� 1325 The value provided does not meet the length, complexity, or 
history requirement of the domain. 

� 1326 Unknown user name or bad password. 

� 1327 User account restriction. 

� 1328 Account logon time restriction violation. 

� 1329 User not allowed to log on to this computer. 

� 1330 The specified account password has expired. 

� 1331 Account currently disabled. 

�  1722 The RPC server is unavailable. 

Normally Servers Alive de-authenticates at the end of any check cycle 
that incorporates authentication.  If for some reason this does not succeed, 
it can cause any subsequent checks to fail.  To force an authentication 
disconnect before a check, add the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\DisconnectBeforeAuthenticationConnection (dword).  
Value of 1 turns this feature on. 

If any error code found within this comma separated list occurs during 
the authentication phase, Servers Alive still sees the authentication as 
being successful. This is not a guarantee that the check as such will pass 
too. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\AuthenticationErrorIgnoreList 
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When you use an NT perfmon check, you can select the performance 
object, counter, and instance to use in the check. For example, you can 
check .NET CLR Exceptions,# of Exceps Thrown,_Global_. 

To open this dialog box, select the following items from the Main 
window: 

� Add button > Entries dialog box > Check tab > Check to Use list: NT 
Perfmon > Browse button. 
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Diskspace 

 

 

Servers Alive can check if there is enough disk space left on a specific 
Windows network share.  The name of the resource must be given as 
\\server\share. 

Servers Alive sends you an alarm when the free space is less then x. 

X can be given as:  

� 25 meaning 25 Bytes  

� 25 kb meaning 25 Kilobytes  

� 25 mb meaning 25 Megabytes  

� 25 gb meaning 25 Gigabytes  

� 25 tb meaning 25 Terabytes  

You can also use percentages in your disk checks.  If you want an alarm 
when less than 5% of the disk space is available, then use "5 %" in the 
text box.  The space between the number and the percent sign is very 
important.  

Check to Use 

Select the protocol that you want to use. 

And Alarm When Less Than ____ _____ 

Enter the conditions for performing the check. 

Authenticate Before Checking  

Click to enable authentication before the check starts.  

Figure 47: Diskspace (1) 
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The user performing the service check needs to have at least power-user 
rights on the computer that is checked. For the process checking you need 
administrator rights. This means that, when Servers Alive runs within the 
context of user_1, user_1 must have power-user or administrator rights on 
the computer that is checked.  

If user_1 does not have sufficient rights, you can specify another user 
name, usually in the form domain\username, and password of a user with 
power-user or administrator rights on the computer that is checked.  

Username 

Enter the user name. 

Password 

Enter the password. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 

The exact byte value of kb/mb/gb/tb can be changed in the registry. 

Values to add/change are as follows : 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\diskspace\kb (string value) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\diskspace\mb (string value) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\diskspace\gb (string value) 

� HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\diskspace\tb (string value) 

By default Servers Alive will choose the next available drive letter to 
connect with when performing a disk space check.  You can force Servers 
Alive to use a specific one if you choose. 

HKLM\SOFTWARE\DBU Consulting\Servers 
Alive\StartUp\ForcedDriveLetter (string value) 
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When performing a disk space check, the %e parameter contains the 
actual free space on the share that is checked. If the compare value is 
given in MB, the %e parameter is also in MB. However, if the compare 
value is given as a percentage, the %e is in bytes. You can now control 
how %e is returned when checking by a percentage by editing this 
registry value: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\DiskSpace\PercentageMeasure (string) 

Possible values: KB MB GB TB (default MB) 
 

URL (HTTP/HTTPS) 
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Servers Alive can perform a URL (Universal Resource Locator) check 
based on the HTTP (web) and HTTPS (secure web) protocol.   

A URL should be something like:  

� http://www.mydomain.com/sub-dir/page.html  

� https://www.mydomain.com/sub-dir/page.html  

For both the HTTP and the HTTPS check, Servers Alive can connect to 
the remote server using a proxy server. This proxy server is defined in the 
Proxy tab of the setup. 

Please note that the only authentication Servers Alive supports for URL 
checking is basic authentication.  The other common method, NTLM, is 
undocumented and non-standard, so it is not supported. 

Check to Use 

Select the protocol that you want to use.  

Then, in the next boxes, you can enter the conditional settings to perform 
the check. For both the HTTP and the HTTPS check, Servers Alive can 
also check if the content of the retrieved page is correct or not. To use 
this functionality you must use the Should contain or Shouldn’t contain 
clause in combination with a word or sentence that should or should not 
be in the retrieved web page. 

In the content check string you can have a portion that is dynamic based 
on the current date.  To do this, add a string that is surrounded by { and } 
and contains some of the following key words: 

dd  day 

mm  short month (01) 

yy  short year (02) 

Mmmm long month (January) 

yyyy  long year (2002) 

For example, “{dd-mm-yy}” translates to “22-01-02”, and “{dd Mmmm 

yyyy}” would translate to “22 January 2002”. 

Password Protected Page 

Click to enable a page that is protected by a password.  

Username 

Enter the user name. 

Password 
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Enter the password. 

No Proxy 

Click to disable proxy authentication or choose to use :0 as the proxy 
entry. Click the check box when you have a direct connection to the 
Internet to retrieve a web page. Some companies or Internet service 
providers force people to use a proxy server. In these cases, you must 
define the proxy server settings by clicking File > Setup and then click the 
General branch of the tree and select the Proxy branch. You can now use 
these settings within the HTTP/HTTPS checks.  

With Cookies 

Select to use cookies in the check. Some web pages send cookies to the 
client before serving the page that you requested. If the page you’re 
checking needs the cookies, you should select this check box. In these 
cases, cookies are session settings that the web server is sending the 
client.  

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 

Servers Alive performs the “contains” check in a case-sensitive way. This 

can be changed by adding or editing the following registry value: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 

Alive\StartUp\URLContentInsensitive (dword) 

1 = case insensitive 

0 = case sensitive (default) 

If you want to specify a different user agent string, you can add or edit 

the following registry key: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 

Alive\Proxy\UserAgent (string) 

The Securityflags key controls how Servers Alive responds to various 

SSL certificate problems.  By default, it maintains the maximum secure 

response to SSL certificate issues and can cause checks to fail.  You can 

change the Securityflags key to vary this response.   

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 

Alive\StartUp\Securityflags (dword) 
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The following flags are defined, as specified in hexadecimal notation. 
They can be ordered together to exclude multiple conditions.  The values 
must be entered as hexadecimal values. 

&H00000001   Ignore time validity status of certificate. 

&H00000002   Ignore time validity status of CTL. 

&H00000004  Ignore non-nested certificate times. 

&H00000010   Allow unknown Certificate Authority. 

&H00000020   Ignore wrong certificate usage. 

&H00000100   Ignore unknown certificate revocation status. 

&H00000200   Ignore unknown CTL signer revocation status. 

&H00000400   Ignore unknown Certificate Authority revocation 
status. 

&H00000800   Ignore unknown Root revocation status. 

&H00008000   Allow test Root certificate. 

&H00004000   Trust test Root certificate. 

&H80000000  Ignore non-matching CN (certificate CN not-matching 
server name). 

Usually, Servers Alive uses one set of 
UserAgent/SecurityFlag/AdditonalHeaders for all URL (HTTP/HTTPS) 
checks. However, if for some reason you want to change them for one or 
more entries, you can do this by editing the entries file directly. 

An example without additional parameters: 

#TYPE=U#PARA="#URL=http://www.company.com#CCO=CON#CO
N=#AUTH=F#USR=#PWD=#PRX=F#COO=F#"#ADPA=""#TIME=10
#SK=F# 

An example with additional parameters: 

#TYPE=U#PARA="#URL=http://www.company.com#CCO=CON#CO
N=#AUTH=F#USR=#PWD=#PRX=F#COO=F#"#ADPA="#ADDITIO
NALHEADERS=Accept-Language: en-us{0d}{0a}Accept-Encoding: 
gzip, deflate#"#TIME=10#SK=F# 

Within the "string," you get a #ADPA="; all information after that, until 
the next ", is for additional parameters. 

Currently you can use 3 types of additional parameters 

� USERAGENT 
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� HTTPSECURITYFLAGS 

� ADDITIONALHEADERS 

Example that uses 2 of the parameters: 

#TYPE=U#PARA="#URL=http://www.company.com#CCO=CON#CO
N=#AUTH=F#USR=#PWD=#PRX=F#COO=F#"#ADPA="#USERAGE
NT=NSPlayer/7.1.0.3055#ADDITIONALHEADERS=Accept-Language: 
en-us{0d}{0a}Accept-Encoding: gzip, deflate#"#TIME=10#SK=F# 

The {0d}{0a} is needed if you want to send several different additional 
headers. 

A CRC check of a URL (HTTP/HTTPS) check retrieves the web page 
and calculates a CRC (checksum) on the content of the page. However, it 
only does this for all that is between the <BODY  and </BODY> 
tags. 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\CRC\StartTAG (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\CRC\EndTAG (string) 

In between those two tags you can still exclude some parts too, often used 
for changing data like a date or time. 

All text in between the following tags is not used for the CRC 
calculation: 

<!--- SA Ignore -->       <!--- SA Resume -->  

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\CRC\StartIgnoreTAG (string) 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\CRC\EndIgnoreTAG (string) 
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URL (RTSP/MMS) 

 

 

Servers Alive can perform a URL (Universal Resource Locator) check 
based on the MMS (Microsoft media server) or RTSP (streaming audio) 
protocol. Servers Alive supports the use of cookies.   

Check to Use 

Select the protocol that you want to use. 

Next, enter the conditionals for the check. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
 

Figure 48: URL 
(RTSP/MMS) (1) 
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Database (Microsoft SQL) 

 

 

Servers Alive works only with Microsoft SQL, and not any other third 
party SQL server. 

Servers Alive can check for the availability of a Microsoft SQL server 
database. To perform this check, it uses the functionality provided by the 
Microsoft SQL client, which you must install separately. Servers Alive 
supports Microsoft SQL 6.5, 7.0 and 2000 clients. The SQL 2000 client is 
seen as SQL7.   

When you want to check a MS SQL database you must provide the name 
of the database, the user name, and the password that is used to connect 
to the database. The SQL server’s name is the hostname. If you have both 
multiple clients installed you can select which client Servers Alive should 
use.  

Check to Use 

Select the protocol that you want to use. 

SQL Server 

Click to use SQL server. These options are available only if you have the 
Microsoft SQL DMO libraries installed on your computer. 

Database 

Enter the name of the database. 

Username 

Figure 49: Database 
(Microsoft SQL) (1) 
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Enter the user name for connecting to the database. 

Password 

Enter the password to connect to the database. 

Libs to Use 

Enter the name of the library that you want to use to connect. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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Database (Oracle) 

 

 

Servers Alive works only with Oracle by Oracle Corporation and not any 
other brand. 

Servers Alive can check the availability of an Oracle database.  To do 
this, the software uses the Oracle OLE object, which is part of the Oracle 
client. Servers Alive supports Oracle 7, Oracle 8 and Oracle 8i, and 
Oracle 9i clients. With Oracle 9i, you must install the Oracle Windows 
Interface included with Oracle.  In most cases, a full installation of the 
Oracle client is needed. When you want to check an Oracle database, you 
must provide the name of the database, the user name, and the password 
that are used to connect to the database.  

Check to Use 

Select the protocol that you want to use. 

Oracle Server 

Click to use an Oracle server. These options are not available unless you 
have installed the Oracle OLE (object linking and embedding) libraries. 

Database 

Enter the name of the database that you want to connect to. 

Username 

Figure 50: Database 
(Oracle) (1) 
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Enter the user name to connect to the database. The database name is a 
name that is defined within the TNSNames.ora file. For more information 
on how to configure entries in the TNSNames.ora file, please consult your 
Oracle documentation. 

Password 

Enter the password to connect to the database. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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Netware 

 

 

Servers Alive works only with Novell Netware Client, and not the 
Microsoft Netware client. 

Servers Alive can check several parameters on your Netware server. For 
these checks, it uses the functionality of the Novell Netware client. If this 
client is not installed, the Netware check options are not available.  

Servers Alive can check:  

� The number of active connections on the Netware server  

� The CPU utilization of the Netware server  

� The number of mounted volumes  

You can configure Servers Alive to send an alarm to you when the 
returned number is below (<), above (>), equal to (=), or different from 
(<>) a base-value.  

The Netware checking only gives a valid result when you are currently 
connected to the Netware server you are checking. 

Check to Use 

Select the protocol that you want to use. 

Alarm When ____ is _____ Than _______ 

Enter the conditional settings for the check. 

Timeout __ Seconds 

Figure 51: Netware (1) 
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Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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SNMP 

 

 

Servers Alive can check the status of a device or host with the Simple 
Network Management Protocol (SNMP). It checks if a certain OID is one 
of the following: 

� Is less than  

� Is greater than  

� Is equal to  

� Is different from (<>) 

� Contains a value 

� Doesn’t contain a value 

You must enter the community string for the SNMP check for 
authentication purposes. By default, on most SNMP systems, this is 
PUBLIC; but it can be different on your systems.  

Servers Alive can, within one check, retry several times to get an answer 
from the host. 

To get a list of valid OIDs for your SNMP-enabled devices, you should 
contact the vendor of the device. They can give you an MIB file that 
contains all the OIDs for the device. 

Check to Use 

Select the protocol that you want to use. 

Check ___ 

Enter the name of the OID that you want to check. 

Figure 52: SNMP (1) 
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And Alert When the Result _____ _________ 

Enter the conditional settings for the check. 

Community String 

Enter the appropriate community string for the server. An SNMPv1 
community string serves as a password. 

Retries 

Select the number of retries that you want to allow. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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External COM 

 

 

Check to Use 

Select the external COM check that you want to use.  

Configure 

Click the Configure button to change the parameters. 

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
 

Figure 53: External 
COM (1) 



 

 Edit Menu 147 

 

External (Errorlevel) 

 

 

Servers Alive has a lot of built-in check types, but Servers Alive cannot 
support all possible check types. To extend the functionality of Servers 
Alive, you can use the External (Errorlevel) check option. With an external 
check, Servers Alive uses an external application to perform an action 
and, based on the returned errorlevel, flags the host entry as being up or 
down. 

Within the command line that Servers Alive must execute for this 
external check, you can use the following variables: 

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last check time  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

Figure 54: External 
(Errorlevel) (2) 
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If you want to test an external check that you wrote without the use of 
Servers Alive, you can use checkerrorlevel.exe. This small tool is installed 
by the Servers Alive Setup program in the Servers Alive directory. It runs 
your application and displays the error level your application returns. 

For more information about checkerrorlevel.exe, see the  External Checks 
(on page 237) section.  

Alarm When the Errorlevel Returned By 

Enter the conditional settings for the check. 

Kill the External Application When Not Stopped in Time 

Shuts down the external application after the timeout has expired. If the 
external application has not returned an errorlevel to Servers Alive within 
the given timeout, Servers Alive flags the host entry as down.  The 
external application continues to run. Servers Alive can, in such a 
situation, kill, or shut down, the external application after the timeout has 
expired.   

Timeout __ Seconds 

Enter the length of time for the timeout in seconds. 

Second Knock 

Enables second knock. If a host is seen as down during a check cycle and 
you have clicked the check box, the software rechecks the host at the end 
of the check cycle to verify that the host is down. This feature is useful if 
you have slow links or computers with slow responses. 
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Alert 

 

 

Servers Alive supports a rich variety of alerting mechanisms.  It supports 
various e-mail alerting options, numeric and alphanumeric paging, 
audible alerts, and more.  You can even write your own custom alerting 
software or use built-in Windows messaging to send popup alerts.  
Servers Alive is also capable of taking remedial action when it 
determines that a server is down, by executing scripts that you create.  
Finally, Servers Alive allows you to easily collect alerting events in a 
central logging server by use of the standard syslog logging mechanism 
available on Unix®  and Windows servers, with third-party software.   

Use the following buttons to add, edit, or delete alert settings: 

� Add  

� Edit  

� Delete 

If you select an option that requires a page to be sent, Servers Alive 

queues multiple pages, but sends only one page at a time. So if there are 

three pages in the queue, Servers Alive connects to the paging company 

for the first page, sends the page, disconnects from the paging company, 

re-connects to the paging company, sends the second page, disconnects, 

and so forth.  

Many of the alerts incorporate keywords to describe a server’s state.  By 

default, it uses the words “up” and “down”, but this can be changed 

through the registry.  Under HKLM\SOFTWARE\DBU 

Consulting\Servers Alive\Status is a list of single letter keys.  Each letter 

corresponds with a particular check type, as follows: 

� D – Drive Space 

Figure 55: Alert (7) 
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� E – External check 

� F – Perfmon 

� I – UDP 

� M – SNMP 

� N – Netware 

� O – Oracle 

� P – Ping 

� Q – MS-SQL 

� R – Process 

� S – Windows Service 

� U – URL 

� X – IPX Ping 

� W – Winsock port (TCP) 

Under each of the single letter keys, you can find numbered string values.  

Each one of these represents a particular status keyword, as follows: 

� 1 – down 

� 2 – possibly down 

� 3 – unavailable 

� 4 – maintenance 

� 5 – up 

� 6 – unchecked 

� 7 – possibly unavailable 

If you want to allow Servers Alive to use “-” and “+,” instead of “down” 

and “up” for all pings, you must set the following registry entries: 

� HKLM\SOFTWARE\DBU Consulting\Servers Alive\Status\P\1 = “-

”  (string) 

� HKLM\SOFTWARE\DBU Consulting\Servers Alive\Status\P\5 = 

“+” (string) 
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Send SMTP Mail (Primary) (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

SMTP (Simple Mail Transfer Protocol) alerting is probably the most 
common alerting used.  SMTP  is used to send e-mail messages to you 
when a down condition is detected.  You should use this as a minimum 
level of reporting.  The SMTP option is  enabled only if you configure the 
global SMTP options from the SMTP branch of the Setup dialog box. 

You can give a primary and an alternate list of recipients for each host. If 
the message must be sent to several e-mail addresses, you can separate 
them with a comma; for example: 
user1@company.com,user2@company.com.  Note that you must provide 
the global SMTP settings for both primary and alternate SMTP entries in 
the SMTP branch of the Setup dialog box before you can enter any 
individual host settings.  

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Using 

Allows you to set conditionals for the message that the alert sends. 

Figure 56: Send SMTP 
Mail (Primary) (Add/Edit 
Alert Dialog Box) (1) 
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To 

Enter the information that you want to appear in the To line of the alert 
message.  If you want to specify multiple recipients, separate them with a 
semicolon. To enter specific information, such as an IP or e-mail address, 
click the Setup button on the Main window and select the Alerts branch of 
the Setup tree. 

When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Select a Person to Add Dialog Box (on page 154) 

Select a Team to Add Dialog Box (on page 154) 

Subject 

Enter the information that you want to appear in the Subject line of the 
alert message. 

Message (Body) 

Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

�  

 

WHEN 
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Select one of the following options to determine when the alert message 
is sent. The alert message can be in the form of a mail message, starting a 
service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 
certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 
down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 
times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 

You can add a custom footer message to all messages sent by Servers 
Alive. To do this, add or edit the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\CustomFooterMessage (string)  

To remove the date/time from the mails, you must add or edit the 
following registry entry: 
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) value 1  
 

 

You can add a person to appear as the recipient of an alert. 

To open this dialog box, click the following items on the Main window: 

� Add button > Entries dialog box > Alert tab > Add button > Any option 
on the list > Add/Edit Alert dialog box > Add button > Person 

 

 
 

 

You can add a team to appear as the recipient of an alert. 

To open this dialog box, click the following items on the Main window: 

� Add button > Entries dialog box > Alert tab > Add button > Any option 
on the list > Add/Edit Alert dialog box > Add button > Team 

 

 
 

Figure 57: Select a Team 
to Add Dialog Box (1) 
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Send SMTP Mail (Alternate) (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

SMTP (Simple Mail Transfer Protocol) alerting is probably the most 
common alerting used.  SMTP  is used to send e-mail messages to you 
when a down condition is detected.  You should use this as a minimum 
level of reporting.  The SMTP option is  enabled only if you configure the 
global SMTP options from the SMTP branch of the Setup dialog box. 

You can give a primary and an alternate list of recipients for each host. If 
the message must be sent to several e-mail addresses, you can separate 
them with a comma; for example: 
user1@company.com,user2@company.com.  Note that you must provide 
the global SMTP settings for both primary and alternate SMTP entries in 
the SMTP branch of the Setup dialog box before you can enter any 
individual host settings.  

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Using 

Allows you to set conditionals for the message that the alert sends. 

Figure 58: Send SMTP 
Mail (Alternate) 
(Add/Edit Alert Dialog 
Box) (2) 
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To 

Enter the information that you want to appear in the To line of the alert 
message.  If you want to specify multiple recipients, separate them with a 
semicolon. To enter specific information, such as an IP or e-mail address, 
click the Setup button on the Main window and select the Alerts branch of 
the Setup tree. 

When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Select a Person to Add Dialog Box (on page 154) 

Select a Team to Add Dialog Box (on page 154)  

Subject 

Enter the information that you want to appear in the Subject line of the 
alert message. 

Message (Body) 

Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

�  

WHEN 
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Select one of the following options to determine when the alert message 
is sent. The alert message can be in the form of a mail message, starting a 
service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 
certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 
down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 
times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 

You can add a custom footer message to all messages sent by Servers 
Alive. To do this, add or edit the following registry entry: 

HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\SMTP\CustomFooterMessage (string)  

To remove the date/time from the mails, you must add or edit the 
following registry entry: 
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HKEY_LOCAL_MACHINE\SOFTWARE\DBU Consulting\Servers 
Alive\ExcludeDateTimeInMail (dword) value 1  
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Send Other Mail (Add/Edit Alert Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Using 

Allows you to set conditionals for the message that the alert sends. 

Message (Body) 

Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  
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� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

�  

 

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 

service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 

down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 

times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 

For example, if you enter 3, Servers Alive sends an alert message on the 

third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 

server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 

down cycle. 

And When Back Up Too 



 

 Edit Menu 161 

 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Alpha Page/SMS (Add/Edit Alert Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

One paging option is Alphanumeric paging or SMS messaging. In order 
to send a page to your pager or GSM, Servers Alive needs the phone 
number, or PIN number, of the pager or GSM. You must also specify the 
message that Servers Alive sends to the pager/GSM. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Using 

Allows you to set conditionals for the message that the alert sends. 

To 

Enter the information that you want to appear in the To line of the alert 
message.  If you want to specify multiple recipients, separate them with a 
semicolon. To enter specific information, such as an IP or e-mail address, 
click the Setup button on the Main window and select the Alerts branch of 
the Setup tree. 
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When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Select a Person to Add Dialog Box (on page 154) 

Select a Team to Add Dialog Box (on page 154) 

Message (Body) 

Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

�  

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 

service, playing a sound, and so forth. You can select options that send 

messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 

down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 
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Specify to send the alert when the server is down a certain number of 
times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Send Network Page (SNPP) (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

To Pager ID 

Enter the pager ID that you want the alert message sent to. 

Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Select a Person to Add Dialog Box (on page 154) 

Select a Team to Add Dialog Box (on page 154) 

Message (Body) 

Figure 59: Send Network 
Page (SNPP) (Add/Edit 
Alert Dialog Box) (1) 
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Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 

service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 

down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 

times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 

For example, if you enter 3, Servers Alive sends an alert message on the 

third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 

server is not operating. 

Always 

Select to send an alert whenever a server is down. 
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When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Numeric Page (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

Paging is another common alerting method.  This important alerting 
option allows you to receive numeric or alphanumeric pages whenever a 
server is down.  Before you can turn this option on for any entries, you 
must have first configured paging in the Setup dialog box.   

Since numeric paging is not based on a real protocol, it is not considered 
a 100% reliable solution. Numeric paging uses the settings that are 
defined in the Numeric Paging branch of the Setup tree. The message that 
is sent to the pager is the host ID, which you can define for each 
individual host. You can also have Servers Alive send an up/down code.  
You can turn this on in the Numeric Paging branch of the Setup tree. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

To 

Figure 60: Numeric Page 
(Add/Edit Alert Dialog 
Box) (1) 
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Enter the information that you want to appear in the To line of the alert 
message.  If you want to specify multiple recipients, separate them with a 
semicolon. To enter specific information, such as an IP or e-mail address, 
click the Setup button on the Main window and select the Alerts branch of 
the Setup tree. 

When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

 Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Select a Person to Add Dialog Box (on page 154) 

Select a Team to Add Dialog Box (on page 154) 

Message (Body) 

Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

�  

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 

service, playing a sound, and so forth. You can select options that send 

messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 
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Specify that Servers Alive sends the alert message when the server is 
down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 
times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Execute Command (Add/Edit Alert Dialog Box) 
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To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

With the Execute Command option, you can configure Servers Alive to 
execute the command of your choice whenever the check status is down.  
You can enter three different types of commands:  

� A normal command: this can be a BAT or EXE file.  You must 
include the full path to the BAT or EXE. 

� Restart of a Windows service, even if you are not checking an NT 
service. You can specify a user name and password to use to restart 
this NT service in the boxes provided.   

� Reboot a Windows computer.  You can specify a user name and 
password to use to reboot the Windows computer.  

Servers Alive records in the logs that a reboot was successful as long as 
the software was able to send the reboot command successfully.  Servers 
Alive does not verify that the computer actually reboots correctly.  If part 
of the operating system does not respond correctly, the system cannot 
reboot despite receiving a reboot command. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Next, in the list box, select the type of command that you want to use. In 
order to use the Reboot and Restart Service options, Servers Alive must 
have sufficient rights, in the form of a user name and password, and 
access to the NetBIOS ports of the remote computer.  If there is a firewall 
between Servers Alive and the remote server, please contact your firewall 
administrator for assistance. 

Command 

Enter the command that you want to execute. When entering the 
command, you must pass in various pieces of information to the 
command you are executing that identify what has broken.  You can use 
the following variables in your command.  They are replaced with the 
associated information before the command is issued. 

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  
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� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 

service, playing a sound, and so forth. You can select options that send 

messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 

down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 

times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 

third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 

server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 

down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 

you choose to receive an e-mail when the host is down N times, but also 

want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 

back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don't receive an alert message for the 

down or up cycle. 
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Sound (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Sound to Hear 

Enter the file name for the sound. You can click the browse button to 
select a WAV file on the computer. 

Test It 

Click to test the alert and sound. 

Beep Via Speaker 

Select this to allow the system beep to alert you. 

WHEN 

Figure 61: Sound 
(Add/Edit Alert Dialog 
Box) (1) 
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Select one of the following options to determine when the alert message 
is sent. The alert message can be in the form of a mail message, starting a 
service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 
certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 
down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 
times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
 



 

176 Servers Alive User’s Guide 

 

Send ICQ Message (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

To 

Enter the information that you want to appear in the To line of the alert 
message.  If you want to specify multiple recipients, separate them with a 
semicolon. To enter specific information, such as an IP or e-mail address, 
click the Setup button on the Main window and select the Alerts branch of 
the Setup tree. 

When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Figure 62: Send ICQ 
Message (Add/Edit Alert 
Dialog Box) (1) 
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Select a Person to Add Dialog Box (on page 154) 

Select a Team to Add Dialog Box (on page 154) 

Message (Body) 

Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

�  

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 

service, playing a sound, and so forth. You can select options that send 

messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 

down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 

times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 

For example, if you enter 3, Servers Alive sends an alert message on the 

third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 
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Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Send MSN Message (Add/Edit Alert Dialog Box) 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

To 

Enter the information that you want to appear in the To line of the alert 
message.  If you want to specify multiple recipients, separate them with a 
semicolon. To enter specific information, such as an IP or e-mail address, 
click the Setup button on the Main window and select the Alerts branch of 
the Setup tree. 

When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Select a Person to Add Dialog Box (on page 154) 
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Select a Team to Add Dialog Box (on page 154) 

You can also add an MSN contact with the Select an MSN Contact to 
Add (on page 181) dialog box. 

 When you click the Add button and select MSN Contact, the dialog box 
might take a minute to appear as the software is logging on to MSN to 
retrieve a list of contacts. 

Message (Body) 

Enter the message that you want for the alert. You must specify the 
message that Servers Alive sends.  You can use the variables listed below 
to help you create informative messages. The message and subject can 
contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

�  

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 
service, playing a sound, and so forth. You can select options that send 

messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 

down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 

times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 
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Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
 

 

You can add an MSN contact. 
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Send WinPOPUP Message (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

To 

Enter the information that you want to appear in the To line of the alert 
message.  If you want to specify multiple recipients, separate them with a 
semicolon. To enter specific information, such as an IP or e-mail address, 
click the Setup button on the Main window and select the Alerts branch of 
the Setup tree. 

When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

Add 

Click this button to add a person, team, or other item to the box using one 
of the following dialog boxes: 

Figure 63: Send 
WinPOPUP Message 
(Add/Edit Alert Dialog 
Box) (1) 
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Select a Person to Add Dialog Box (on page 154) 

Select a Team to Add Dialog Box (on page 154) 

Message 

Enter the message that you want to receive as an alert. You must specify 
the message that Servers Alive sends.  You can use the variables listed 
below to help you create informative messages. The message and subject 
can contain these variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 

WHEN 

Select one of the following options to determine when the alert message 

is sent. The alert message can be in the form of a mail message, starting a 

service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 

certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 

down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 

times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 

For example, if you enter 3, Servers Alive sends an alert message on the 

third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 
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Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Send SNMP Trap (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Object OID 

Enter the object ID. 

Object Value 

Enter the value for the object. 

WHEN 

Select one of the following options to determine when the alert message 
is sent. The alert message can be in the form of a mail message, starting a 
service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 
certain conditions. 

When __ Times Down 

Figure 64: Send SNMP 
Trap (Add/Edit Alert 
Dialog Box) (1) 
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Specify that Servers Alive sends the alert message when the server is 
down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 
times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Do an SNMP SET (Add/Edit Alert Dialog Box) 

 

 

To access this dialog box, click the Add button on the Alert tab of the 
Entries dialog box. 

WHAT 

Displays the type of alert that you selected by clicking the Add or Edit 
button on the Alert tab. 

Host 

Enter the name of the remote host. 

Object OID 

Enter the object ID. 

Object Value 

Enter the value for the object. 

WHEN 

Figure 65: Do an SNMP 
SET (Add/Edit Alert 
Dialog Box) (1) 
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Select one of the following options to determine when the alert message 
is sent. The alert message can be in the form of a mail message, starting a 
service, playing a sound, and so forth. You can select options that send 
messages when the server status changes or when a host is down with 
certain conditions. 

When __ Times Down 

Specify that Servers Alive sends the alert message when the server is 
down the number of times that you specify. 

When __ Times Down and All Next Down Cycles 

Specify to send the alert when the server is down a certain number of 
times and all the subsequent cycles that the server is down. 

Every __ Down Cycles 

Specify an alert is sent the number of the cycle that the server is down. 
For example, if you enter 3, Servers Alive sends an alert message on the 
third, sixth, ninth, and so forth, down cycle. 

When __ % of the Last Cycles Are Down 

Click to send an alert after a percentage of the recent cycles in which the 
server is not operating. 

Always 

Select to send an alert whenever a server is down. 

When Back Up After a Down 

Click to send an alert message when the server comes back up after a 
down cycle. 

And When Back Up Too 

Select to send an alert message when the server is operational again. If 
you choose to receive an e-mail when the host is down N times, but also 
want a message when the server comes back up, you must select the And 
When Back Up Too option.  For example, if you enter 3 and the server is 
back up on the third cycle, you receive an alert message. If the server 
comes back up after two cycles, you don’t receive an alert message for the 
down or up cycle. 
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Output 

 

 

If you want to collect all of the up/down events that Servers Alive detects 
into a centralized logging server, you can use the settings on this tab.  
Syslog is a standard method of sending alerts to an alerting server. Free 
server implementations exist for both Windows and Unix platforms.   

For a Windows based syslog server, we recommend Kiwi Syslog 
Daemon, available from http://www.kiwisyslog.com 
(http://www.kiwisyslog.com/)/. 

Include on Below HTML Pages 

Records the output on the HTML pages that you specify. 

Add 

Click to add an HTML page. 

Delete 

Select a page and click this button to remove it. 

Log to Syslog Server 

Click to activate logging to the syslog server. 

Facility 

Enter the appropriate facility to use when logging to a Syslog server.  For 
most, the Kern facility should be fine.  If not, check with your Syslog 
server documentation to determine the best setting. 

Figure 66: Output (1) 
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Message 

Enter the message for the log. You must enter the message that Servers 
Alive records in the log. This message can use the following variables:  

� %h for the host name  

� %p for the pretty name  

� %s for the status  

� %t for the last checktime  

� %d for the date  

� %u for the unique ID of the host  

� %c for the complete host/check description  

� %e for extra info (for a URL checking this could contain 404 Not 
Found as error message)  

� %a for additional info (for a ping check this will the round trip time)  

� %i for hostid (used for numeric paging)  

� {0d} for chr(13) – carriage return 

� {0a} for chr(10) – line feed 
 

Add HTML Page 

 

 

Select the HTML page from the list and click OK. 
 

Figure 67: Add HTML 
Page (2) 
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Schedule 

 

 

Many servers have a designated period of time during the week when 
they are unavailable.  These are generally times for scheduled 
maintenance or backups.  Instead of manually changing each host into 
maintenance mode every time it needs to maintenance services, you can 
set up a schedule to tell Servers Alive when it should start and stop 
checking a host.  You do this with the Schedule tab. 

Grid 

To change the schedule, you must first select a time.  Each block 
represents an hour.  You cannot select a finer time scale than an hour.  
Click and drag the pointer to select the hours you want to change and 
then click the Check or Don’t check buttons. The blocks change color to 
signify the changed status. 

Check 

Click this button after you have selected a time period on the grid. This 
button allows Servers Alive to check a host during the time period that 
you selected. 

Don't Check 

Click this button after you have selected a time period on the grid. This 
action tells Servers Alive to not check a host during the time period that 
you selected. 

When to Check (Priority) 

Figure 68: Schedule (2) 
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Select an option on the list if the entry represents a server that does not 
need checking as often as the others and you want Servers Alive to check 
the host only periodically. Select an item on the list to check the host 
every cycle or once out of a certain number of cycles. For example, you 
can select 1 out of Every 2 Cycles. 

Ignore Priority When Down 

Click the check box to check a host on every check cycle when the host is 
down, until it is back up. 
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New Entry Based On . . . 

You can create entries based on a template with the New Entry Based On 
command on the Edit menu. You can use this command to create similar 
entries, based on an entry that already exists.  For example, if you have 
many web servers, you can create an entry to check one web server and 
then use this option to quickly create similar checks for the others.   

To use this option, first select an entry on the Main window.  Then either 
press CTRL-D or select Edit > New Entry Based On.  When the dialog box 
appears, change the host and  other information that needs changing.   
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Import Hosts 

 

 

You can click Edit > Import Hosts to import a host entry. 

File to Import 

Enter the name of the file for the host that you want to import. Click the 
browse button to select a file on your computer. 

First Row is Header 

Click the check box if the file that you are importing has a header row. 

Delimiter 

Select the delimiter that is used to separate columns in the file that you 
are importing. 

Tab 

Select if the import file contains tab characters that separate the columns. 

Space 

Select if the import file contains spaces that separate the columns. 

Semicolon 

Select if the import file contains semicolons that separate the columns. 

Figure 69: Import Hosts 
(2) 
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Comma 

Select if the import file contains commas that separate the columns. 

None 

Select if the import file does not have a delimiter.  

Template Entries 

Displays a list of the entries on the computer that you can use as a 
template. If an entry has a check mark by it in the Main window, it does 
not appear on this list. 

Find 

Enter a host name in the box and click the Find button to find a host in the 
Template Entries list. 

Find Next 

Click the button to find the host name again. 

Import 

Click this button to complete the import. 
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Edit 

Select an entry in the Main window and then click Edit > Edit to change 
the settings of a specific host. You can change the settings on the Entries 
dialog box (on page 103). 
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Delete 

You have two options for deleting hosts.  You can delete them on a host-
by-host basis, or for more extreme circumstances, delete all hosts at once.   

Before using either option, you must confirm your decision to prevent 
accidents.  If you accidentally delete all your entries, do not close Servers 
Alive, as it might have been configured to automatically save any 
changes in the Setup dialog box.   

First re-open the default host list and verify that all hosts are still listed.  
Then select Save to verify that your copy is available the next time 
Servers Alive loads.   

Woodstone bvba recommends that you backup your entry listing on a 
regular basis. To do this, click File > Save As. 
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Delete All 

You have two options for deleting hosts.  You can delete them on a host-
by-host basis, or for more extreme circumstances, delete all hosts at once.   

Before using either option, you must confirm your decision to prevent 
accidents.  If you accidentally delete all your entries, do not close Servers 
Alive, as it might have been configured to automatically save any 
changes in the Setup dialog box.   

First re-open the default host list and verify that all hosts are still listed.  
Then select Save to verify that your copy is available the next time 
Servers Alive loads.   

Woodstone bvba recommends that you backup your entry listing on a 
regular basis. To do this, click File > Save As. 
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Global Change (Replace) 

 

 

Occasionally, you must make entry revisions on a global level.  For 
example, you might want to change your paging provider or need to send 
all primary SMTP messages to a new address.  To do this, click Edit >  
Global Change (Replace) to make the changes. 

Before making global changes, you might want to stop the current check 
cycle and make a backup of your current listing with File > Save As.   

Change 

Select the parameter that you want to change: 

� Primary SMTP Message 

� Alternate SMTP Message 

� Primary SMTP: Send Mail to... 

� Alternate SMTP: Send Mail to... 

� Ignore Priority When Down... 

� NT service check password 

� NT process check password 

� Pager number 

� Syslog message 

� NT performance check password 

� NT service check username 

� NT process check username 

� NT performance check username 

� Alpha paging enabled 

� Primary SMTP subject 

� Alternate SMTP subject 

� Disk space check username 

� Disk space check password 

To 

Figure 70: Global 
Change (2) 
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Enter the new value for the parameter that you selected in the Change list. 

Start 

Click when you are ready to make changes.  
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People 

 

 
  

If you click Edit > People, you can add people and set up settings for 
SMTP, paging, ICQ messages, and MSN messages for each person. 
 

Figure 71: People (3) 
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Person 

 

 

You can enter alert and message settings for each person that you add to 
Servers Alive. For an example of how to use people and teams, refer to 
the People and Teams Example (on page 217). 

Select Person 

Enter the name of the person that you want to create message settings for. 

Add 

Click to add people to the Select Person list with the Add (on page 207) 
dialog box. 

Delete 

Select a person in the Select Person list and click Delete to remove them. 

Name 

Displays the name of the person that you chose in the Select Person list. 
You can change the name. 

Person is Active 

Click to activate the person’s settings. 

Figure 72: Person (1) 
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Remarks 

Enter information, such as notes, that you want to remember for that 
person’s entry. 

A Public Holiday Should Be Considered as a Sunday 

Click to ensure that holidays are treated as a day off in the messaging 
settings. 

NTUserID 

Enter the Microsoft NT user id for the person. 
 

 

 
 

This dialog box allows you to add several items, such as HTML pages, 
teams, or people, to a list on the previous dialog box. Type the name of 
the item that you want to add and click OK. 
 

Figure 73: Add Dialog 
Box (1) 
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SMTP 

 

 

Enable SMTP Mail for This Person 

Click to send SMTP messages to the person that you selected on the 
Person tab. 

Send SMTP Mail To __________ Using the Green Schedule 

Enter the e-mail address that you want to use for the green schedule on 
the grid.  

In each of the Send SMTP Mail To boxes, you can enter several addresses 
separated by commas. For example, you can enter 
Janesmith@serversrus.com,johnsmith@serversrus.com. 

Send SMTP Mail To __________ Using the Blue Schedule 

Enter the e-mail address that you want to use for the blue schedule on the 
grid.  

Send SMTP Mail To __________ Using the Yellow Schedule  

Enter the e-mail address that you want to use for the yellow schedule on 
the grid.  

Figure 74: SMTP (1) 
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Grid 

To change the schedule, you must first select a time.  Each block 
represents 15 minutes.  You cannot select a finer time scale than 15 
minutes.  Click and drag the pointer to select the time period that you 
want to change and then click one of the Send or Don’t Send buttons. The 
blocks change color to signify the schedule. The various colors for each 
schedule cannot overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the 
grid to select a time period. This button allows Servers Alive to send a 
message during the time period that you selected. For example, if you 
drag the cursor and then click the green Send button, an alert that occurs 
at that time is sent to the address entered in Send SMTP Mail To 
__________ Using the Green Schedule.  

Don’t Send 

Click this button after you have selected a time period on the grid. This 
action tells Servers Alive not to send a message during the time period 
that you selected. 
 

Pager 
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Enable Paging for This Person 

Click to send SMTP messages to the person that you selected on the 
Person tab. 

Page Him/Her At __________ Using the Green Schedule 

Enter a number. 

In each of the Page Him/Her boxes, you can enter several numbers 
separated by semi-colons with no dashes. for example, you can enter 
7723895,7723896. 

Page Him/Her At __________ Using the Blue Schedule 

Enter a number. 

Page Him/Her At __________ Using the Yellow Schedule  

Enter a number. 

Grid 

To change the schedule, you must first select a time.  Each block 
represents 15 minutes.  You cannot select a finer time scale than 15 
minutes.  Click and drag the pointer to select the time period that you 
want to change and then click one of the Send or Don’t Send buttons. The 
blocks change color to signify the schedule. The various colors for each 
schedule cannot overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the 
grid to select a time period. This button allows Servers Alive to send a 
message during the time period that you selected. For example, if you 
drag the cursor and then click the green Send button, an alert that occurs 
at that time is sent to the number entered in Page Him/Her At __________ 
Using the Green Schedule.  

Don’t Send 

Click this button after you have selected a time period on the grid. This 
action tells Servers Alive not to send a message during the time period 
that you selected. 
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ICQ 
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Enable ICQ for This Person 

Click to send SMTP messages to the person that you selected on the 
Person tab. 

ICQ Him/Her At __________ Using the Green Schedule 

Enter an ICQ number. 

In each of the ICQ Him/Her boxes, you can enter ICQ numbers separated 
by commas. For example, you can enter 1233333,12111. 

ICQ Him/Her At __________ Using the Blue Schedule 

Enter an ICQ number. 

ICQ Him/Her At __________ Using the Yellow Schedule  

Enter an ICQ number. 

Grid 

To change the schedule, you must first select a time.  Each block 
represents 15 minutes.  You cannot select a finer time scale than 15 
minutes.  Click and drag the pointer to select the time period that you 
want to change and then click one of the Send or Don’t Send buttons. The 
blocks change color to signify the schedule. The various colors for each 
schedule cannot overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the 
grid to select a time period. This button allows Servers Alive to send a 
message during the time period that you selected. For example, if you 
drag the cursor and then click the green Send button, an alert that occurs 
at that time is sent to the number entered in ICQ Him/Her __________ 
Using the Green Schedule.  

Don’t Send 

Click this button after you have selected a time period on the grid. This 
action tells Servers Alive not to send a message during the time period 
that you selected. 
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MSN 
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Enable MSN for This Person 

Click to send SMTP messages to the person that you selected on the 
Person tab. 

MSN Him/Her At __________ Using the Green Schedule 

Enter an MSN address. 

In each of the MSN Him/Her boxes, you can enter MSN addresses 
separated by commas. For example, you can enter 
johnsmith@msn.com,janesmith@msn.com. 

MSN Him/Her At __________ Using the Blue Schedule 

Enter an MSN address. 

MSN Him/Her At __________ Using the Yellow Schedule  

Enter an MSN address. 

Grid 

To change the schedule, you must first select a time.  Each block 
represents 15 minutes.  You cannot select a finer time scale than 15 
minutes.  Click and drag the pointer to select the time period that you 
want to change and then click one of the Send or Don’t Send buttons. The 
blocks change color to signify the schedule. The various colors for each 
schedule cannot overlap. 

Send 

Click one of the Send buttons after you have dragged the cursor on the 
grid to select a time period. This button allows Servers Alive to send a 
message during the time period that you selected. For example, if you 
drag the cursor and then click the green Send button, an alert that occurs 
at that time is sent to the address entered in MSN Him/Her __________ 
Using the Green Schedule.  

Don’t Send 

Click this button after you have selected a time period on the grid. This 
action tells Servers Alive not to send a message during the time period 
that you selected. 
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Teams 

 

 

Servers Alive has a great option for companies that use large technical 
teams to handle their support.  You can use team alerting to send alerts to 
multiple people based on schedules for each individual.  This way, you 
can tell Servers Alive what people are responsible for various servers and 
let the software alert the team as appropriate based on the people’s 
schedule of availability.   

To use team alerting, you must set up person and team entries that define 
who should be alerted and when.  To do this, click Edit > People and Edit 
> Teams.  

You must first add the people that you want with the Edit > People 
command. 

You can use both team and people definitions in your alerting.  When 
setting up an entry, you can use either a team or person entry on the SMTP 
and Paging alert settings. To do this, click the Add or Edit button on the 
Main window and, on the Alert tab, click the Add button to select one of 
the SMTP or paging options.  For an example of how to use people and 
teams, refer to the People and Teams Example (on page 217). 

When using a person entry, you can enclose the person’s name in 
parentheses, like (person).  When using a team definition, enclose the 
team name in curly braces, like {team}.  

Figure 75: Teams (1) 
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Select Team 

Enter the name of the team. 

Add 

Click to add people to the Select Team list. 

Delete 

Select a name in the Select Team list and click Delete to remove the team. 

Name 

Displays the name of the team that you chose in the Select Team list. You 
can change the name. 

Active Team? 

Click to activate the team’s settings. 

Remarks 

Enter information, such as notes, that you want to remember for that 
team’s entry. 

People 

Displays people that you can add to the team. 

Members of the Team 

Click the arrow buttons to add or remove people from the team. 
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People and Teams Example 

Suppose your company has four people who are responsible for your 
servers.  These four people are named Jack, Bob, Susan, and Kathy.  
During the day, when all four are at the office, you want them all to 
receive any alert, but the four need some time when they are not on call.  
After looking at their schedules, you determine that each one of them can 
take a weeknight.   

For the weekend, you decide to pair Jack and Kathy and Bob and Susan 
into sub-teams.  Jack and Kathy handle Friday night and Saturday.  Bob 
and Susan handle Sunday and Monday morning before the office opens.  
When you designate two people to receive weekend pages, they can 
travel on weekends if necessary.  In order to allow Jack and Kathy to not 
receive any pages Saturday night, they go off call at 11PM that night. 

So, for all four, here is their schedule: 

� Bob:  All Business Hours, Monday Night, Saturday 11PM - Monday 
8AM 

� Jack: All Business Hours, Tuesday Night, Friday 5PM - Saturday 
11PM 

� Kathy: All Business Hours, Wednesday Night, Friday 5PM - 
Saturday 11PM 

� Susan:  All Business Hours, Thursday Night, Saturday 11PM - 
Monday 8AM 

To set this up, you would first go to the Edit menu and select People.  On 
the Person tab, You must create entries for all four people. Click the Add 
button on the right and enter each person’s name.   

You cannot enter capital letters.   

After you have added each person, go back to each one and check the 
Person is Active box.  This means that they can be paged or e-mailed.  If a 
person goes on vacation, you can remove the check mark later.  One 
consideration with setting up a person’s schedule is in how Servers Alive 
deals with public holidays and alerting.  By default, a public holiday is 
not treated differently than any other day.  You can configure Servers 
Alive to treat public holidays as a Sunday by checking the A public 
Holiday Should be Considered as a Sunday check box.  This means that if 
a holiday falls on a Tuesday, you can designate Servers Alive to check 
everyone’s Sunday schedule instead of his or her Tuesday schedule to 
determine whom to alert.  You can change the list of holidays by clicking 
File > Setup and then clicking General > Startup in the Setup tree. See the 
Startup Settings (on page 80) for more information. 
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Next you must set up each person’s e-mail and pager schedule.  Select 
Bob and then select the SMTP tab.   

First, you should check the Enable SMTP Mail for this Person box and 
enter an e-mail address for Bob.  By default, Bob is scheduled to receive 
e-mail alerts all the time, as indicated by every green time block.  You 
select the time periods when Bob is not on-call and turn them off.   

First, you set the weekdays.  Bob is on call Monday night, but he is off 
call Tuesday, Wednesday, and Thursday nights.  Select each night that 
Bob is off call and click the Don’t Send button to turn them off.   

You can now set Bob’s weekend schedule.  Bob goes off-call on Friday at 
5 PM, so go to the row labeled Friday and select everything from Friday 
5 PM on, and then click the Don’t Send button.  Bob stays off call until 11 
PM Saturday night, so select the entire row labeled Saturday, up to 11 
PM.  Then click the Don’t Send button.  Bob’s schedule is now set, and he 
will not receive e-mails during the time period that he is off call.  Your 
screen should look like the following: 
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Now that you’ve seen how to set up one person, you can do similar 
schedules for the other three people.   

The final step is to add all four people to a team.  You can create teams 
with whatever combination of the four you need, depending on what they 
were responsible for.  You might include some of them in a team called 
"Web" that dealt with your web servers and others in a team that dealt 
with your network, and so forth.  By setting everyone up in a team, you 
can  add a team name to the alerting section of a host entry and then 
modify the team when necessary.   

To add all four people to a team, click Edit > Teams.  To create a team, 
you must click the Add button and give the team a name.  Finally, at the 
bottom of the dialog box, you select all the team members.  In this 
example in which you are creating one team, you select all four people.   
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Protocols 

 

 

You can create settings for each protocol under a unique name: 

� TCP 

� UDP 

� DNS Query 

� Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the 
tree under the specific protocol that you selected. You can now click the 
new branch of the tree to create specific settings for the name that you 
created.  
 

Figure 76: Protocols (1) 
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TCP 

 

 

You can create settings for each protocol under a unique name: 

� TCP 

� UDP 

� DNS Query 

� Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the 
tree under the specific protocol that you selected. You can now click the 
new branch of the tree to create specific settings for the name that you 
created.  

When you click a branch of the tree under TCP, the following options 
appear. The entries depend on the name in the tree that you have selected, 
such as FTP, Gopher, or a name that you created. 

Figure 77: Protocols (1) 
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Protocol Name 

Displays the name of the protocol settings. 

Clone  

Duplicates the settings. Click the button to copy the settings and enter a 
name for the new group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Description 

Displays a description for the protocol settings. 

Packet to Receive on Connect 

Enter the packet the protocol settings can receive. 

On the Internet, the network breaks messages into parts of a certain size 
in bytes called packets. Each packet carries the information that moves 
the packet to its destination: the sender’s IP address, the receiver’s IP 
address, information that tells the network how many packets this e-mail 
message has been broken into, and the number of this particular packet. 
The packets carry the data in the protocols that the Internet uses: 
Transmission Control Protocol/Internet Protocol (TCP/IP). Each packet 
contains part of the body of your message. A typical packet contains 
perhaps 1,000 or 1,500 bytes.  

Anything 

Allows the computer to receive any packets. 

Contains 

Click this and enter the item in Packet to Receive on Connect. 

Equal 

Click this and enter the item in Packet to Receive on Connect. 

Packet to Send on Connect 

Enter the packet the protocol settings can send. 

Packet to Receive as Response 

Enter the packet the protocol settings can receive as a response. 
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Anything 

Allows the computer to receive any packets. 

Contains 

Click this and enter the item in Packet to Receive as Response. 

Equal 

Click this and enter the item in Packet to Receive as Response. 

Packet to Send when Disconnecting 

Enter the packet the protocol settings can send when disconnecting. 
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UDP 

 

 

You can create settings for each protocol under a unique name: 

� TCP 

� UDP 

� DNS Query 

� Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the 
tree under the specific protocol that you selected. You can now click the 
new branch of the tree to create specific settings for the name that you 
created.  

When you click a branch of the tree under TCP, the following options 
appear. The entries depend on the name in the tree that you have selected, 
such as Half Life or a name that you created. 

Figure 78: Protocols (1) 
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Protocol Name 

Displays the name of the protocol settings. 

Clone  

Duplicates the settings. Click the button to copy the settings and enter a 
name for the new group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Description 

Displays a description for the protocol settings. 

Packet to Receive on Connect 

Enter the packet the protocol settings can receive. 

On the Internet, the network breaks messages into parts of a certain size 
in bytes called packets. Each packet carries the information that moves 
the packet to its destination: the sender’s IP address, the receiver’s IP 
address, information that tells the network how many packets this e-mail 
message has been broken into, and the number of this particular packet. 
The packets carry the data in the protocols that the Internet uses: 
Transmission Control Protocol/Internet Protocol (TCP/IP). Each packet 
contains part of the body of your message. A typical packet contains 
perhaps 1,000 or 1,500 bytes.  
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Anything 

Allows the computer to receive any packets. 

Contains 

Click this and enter the item in Packet to Receive on Connect. 

Equal 

Click this and enter the item in Packet to Receive on Connect. 

Packet to Send on Connect 

Enter the packet the protocol settings can send. 

Packet to Receive as Response 

Enter the packet the protocol settings can receive as a response. 

Anything 

Allows the computer to receive any packets. 

Contains 

Click this and enter the item in Packet to Receive as Response. 

Equal 

Click this and enter the item in Packet to Receive as Response. 

Packet to Send when Disconnecting 

Enter the packet the protocol settings can send when disconnecting. 
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DNS Query 

 

 

You can create settings for each protocol under a unique name: 

� TCP 

� UDP 

� DNS Query 

� Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the 
tree under the specific protocol that you selected. You can now click the 
new branch of the tree to create specific settings for the name that you 
created.  

When you click a branch of the tree under TCP, the following options 
appear. The entries depend on the name in the tree that you have selected, 
such as Default DNS IPv4 Query or a name that you created. 

Figure 79: Protocols (1) 
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Protocol Name 

Displays the name of the protocol settings. 

Clone  

Duplicates the settings. Click the button to copy the settings and enter a 
name for the new group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Description 

Displays a description for the protocol settings. 

Type of Record to be Checked 

Select the type of record from the list. 

Test 

Click to test the settings. 

Host or Domain to Query for 

Enter the URL or name of the domain or host for the check. 

Result Should _____  
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Select from Be Anything, Exactly Be, or Contain. Enter the text that should 
result. 
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Radius 

 

 

You can create settings for each protocol under a unique name: 

� TCP 

� UDP 

� DNS Query 

� Radius 

Create a New ___ Protocol 

Select the type of protocol for which you want to create a new setting. 

Named 

Enter the name for the group of settings. 

Add 

Click to add the name to the tree. The name appears as a branch of the 
tree under the specific protocol that you selected. You can now click the 
new branch of the tree to create specific settings for the name that you 
created.  

When you click a branch of the tree under TCP, the following options 
appear. The entries depend on the name in the tree that you have selected, 
such as Default Radius Check or a name that you created. 

Figure 80: Protocols (1) 
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Protocol Name 

Displays the name of the protocol settings. 

Clone  

Duplicates the settings. Click the button to copy the settings and enter a 
name for the new group of settings. 

Delete 

Deletes the settings. 

Default Port 

Displays the default port of the protocol settings. 

Description 

Displays a description for the protocol settings. 

Username 

Enter the user name. 

Password 

Enter the password. 

Shared Secret 

Enter the appropriate shared secret. A shared secret is a text string that 
serves as a password between: 

� A Radius client and Radius server.  

� A Radius client and a Radius proxy.  

� A Radius proxy and a Radius server.  
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You can do the following from the Register, View, and Help menus: 

� Register the product. If you have already registered, you cannot see 
this menu. 

� Show and hide various components of the Main window. 

� Access online Help and the Servers Alive web site. 

In This Chapter 

Register Menu.................................................................... 235 
View Menu ........................................................................ 236 
Help Menu ......................................................................... 236 

 
 

Register Menu 

This menu appears only in the unregistered version of Servers Alive. Use 
this command to register Servers Alive when you receive your e-mail 
containing the appropriate information.  

 

Name 

Enter your name. 

Company 

Enter the name of your company. This entry is optional. 

Registration Code 

Enter the registration code that you received in e-mail from Servers 
Alive. 
 

C H A P T E R  5  

Register, View, and Help Menus 
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View Menu 

You can use the View menu to hide or show the following: 

� Host ID Column 

� Last Checktime Column 

� Roundtrip Column 

� Response Column 

� Status Column 

� Pretty Name Column 

� Host Name Column 

� Check Description Column 

� Status Icons within Tree 

� Hide Status Frame 

� Show EDIT Buttons 

The status frame is right under the menu bar.  It shows how many entries 
were up, down, and in maintenance during the last check cycle.  The edit 
buttons are below the entry list (Add, Edit, Delete, Setup, About, Exit). 

 
 

Help Menu 

Use this menu to access online Help or go to the Servers Alive web site. 

If you click Help > About, you can see information about Servers Alive. 
On the About box under the OK button, a button called Upgrade appears, 
if you have the standard edition of Servers Alive.  If you click this button, 
the Registration dialog box appears,  in which you can enter the Version 4 
Enterprise registration code. If you’re running the non-registered version, 
also known as freeware, or Enterprise edition, you cannot see this button. 

To get additional information about a dialog box or command, select the 
menu command and press F1on the keyboard. Or, you can open a dialog 
box and press F1. 
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One of the nicest options available in Servers Alive is the ability to write 
your own custom checks and have them included in the check cycle.  
These checks can do any task that you are capable of programming, and 
many people in the Servers Alive community have made external checks 
that are available for you to use.  Woodstone bvba has also provided 
some external checks for you to use. 

To use Servers Alive to write external checks, see the External 
(Errorlevel) (on page 147) section. 

Writing External Checks 

External checks can be written in any language.  They can be compiled 
programs, interpreted scripts, or a simple batch file.  There are only a few 
requirements for an external check.  The external check must not rely on 
user input, and it must return an errorlevel to Servers Alive.  Servers 
Alive uses the returned error level to determine if the check succeeded or 
failed.   

Woodstone bvba Supplied Checks 

Woodstone bvba has supplied some example external checks to you.  
They are located in a subdirectory of the Servers Alive install directory 
called external.  In that directory you can find the executable for each 
check, and a small text file that describes its use.  Following is a short 
description of what each does.  Please read the associated text file for 
more details. 

CheckODBC - Checks an ODBC data source.  It will attempt to connect to 
a data source with parameters you give to it.  It does not attempt to read 
or write any data from the data source. 

Countfiles - Connects to a path you supply, such as a network share, and 
returns an errorlevel equal to the number of files/directories that match 
your pattern criteria.  The pattern is a standard file name wildcard pattern 
(such as *.*, *.log, or text?.txt). 

SATelnet - Automates connecting to a TCP port, reading data, and passing 
in commands.  This is ideal for checks where you need to connect to the 
Telnet port of a remote machine, log in, issue some commands, and 
evaluate the result.  For information on the many options available in this 
external check please read the associated text file. 
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SMTP2POP3 - Provides a more detailed check of a mail server than   
checking to see if the SMTP and POP3 ports are open.  This application 
will, when properly configured, send an e-mail through the SMTP server, 
and then collect that same e-mail through the same or a different POP3 
server.  This verifies that the entire mail delivery process is functioning. 

External Checking Without Using Servers Alive 

If you want to test an external check that you wrote without the use of 
Servers Alive, you can use Checkerrorlevel.exe. This small tool is 
installed by the Servers Alive setup program in the Servers Alive 
directory. It runs your application and shows you the errorlevel that your 
application returns.  

 

Command to Execute 

Enter the command. 

Max Wait Time 

Enter the amount of time to wait until the command executes. 

Kill After Max Time Elapsed? 

Click this check box if you want the check stopped after the maximum 
time. 
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